documentation so that we can continuously improve its accuracy and usability.

We seriously consider every customer comment we receive. You can reach us at tech_comm@waters.com.

Contacting Waters

Contact Waters® with enhancement requests or technical questions regarding the use, transportation, removal, or disposal of any Waters product. You can reach us via the Internet, telephone, or conventional mail.

Waters contact information:

<table>
<thead>
<tr>
<th>Contacting medium</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet</td>
<td>The Waters Web site includes phone numbers for Waters locations worldwide. Go to <a href="http://www.waters.com">www.waters.com</a>, and click About Waters &gt; Worldwide Offices.</td>
</tr>
<tr>
<td>Telephone</td>
<td>In the USA or Canada, phone 508 478-2000.</td>
</tr>
<tr>
<td>Conventional mail</td>
<td>Waters Corporation</td>
</tr>
<tr>
<td></td>
<td>34 Maple Street</td>
</tr>
<tr>
<td></td>
<td>Milford, MA 01757</td>
</tr>
<tr>
<td></td>
<td>USA</td>
</tr>
</tbody>
</table>

Safety considerations

Some reagents and samples used with Waters instruments and devices can pose chemical, biological, and radiological hazards. You must know the potentially hazardous effects of all substances you work with. Always follow
Good Laboratory Practice, and consult your organization’s safety representative for guidance.

When you develop methods, follow the “Protocol for the Adoption of Analytical Methods in the Clinical Chemistry Laboratory,” *American Journal of Medical Technology*, 44, 1, pages 30–37 (1978). This protocol addresses good operating procedures and the techniques necessary to validate system and method performance.

**Considerations specific to the Q-Tof Premier mass spectrometer**

**Solvent leakage hazard**

The source exhaust system is designed to be robust and leak-tight. Waters recommends you perform a hazard analysis, assuming a maximum leak into the laboratory atmosphere of 10% HPLC eluate.

**Warning:**

- To confirm the integrity of the source exhaust system, renew the source O-rings at intervals not exceeding one year.
- To avoid chemical degradation of the source O-rings, which can withstand exposure only to certain solvents (see “Common ingredients used to prepare mobile phases” on page E-3), determine whether any solvents you use that are not listed in “Common ingredients used to prepare mobile phases” are chemically compatible with the composition of the O-rings.

**Flammable solvents hazard**

**Warning:** To prevent the ignition of accumulated solvent vapors inside the source, maintain a continuous flow of nitrogen through the source whenever significant amounts of flammable solvents are used during instrument operation.

Never let the nitrogen supply pressure fall below 400 kPa (4 bar, 58 psi) during analyses that require flammable solvents. Connect to the LC output with a gas-fail connector to stop the LC solvent if the nitrogen supply fails.
High temperature hazard

**Warning:** To avoid burn injuries, avoid touching the source enclosure with your hand when operating or servicing the instrument.

Mass spectrometer high temperature hazard:
High voltage hazard

**Warning:**

- To avoid electric shock, do not remove the mass spectrometer’s protective panels. The components they cover are not user-serviceable.

- To avoid nonlethal electric shock when the instrument is in Operate mode, avoid touching the areas marked with the high voltage warning symbol. To touch those areas, first put the instrument in Standby mode.

**Mass spectrometer in ESI ionization mode:**
Safety advisories

Consult Appendix A for a comprehensive list of warning and caution advisories.

Operating this system

When operating the Waters Protein Expression System, follow standard quality control procedures and the guidelines presented in this section.

Intended use

Waters Protein Expression System can be used as a research tool to deliver qualitative protein identification and quantification. It is not for use in diagnostic procedures.

Calibrating

To calibrate UPLC systems, follow acceptable calibration methods using at least five standards to generate a standard curve. The concentration range for standards should include the entire range of quality-control samples, typical specimens, and atypical specimens.

To calibrate mass spectrometers, consult the calibration section for the operator’s guide of the instrument you are calibrating.

Quality control

Routinely run three quality-control samples that represent subnormal, normal, and above-normal levels of a compound. Ensure that quality-control sample results fall within an acceptable range, and evaluate precision from day to day and run to run. Data collected when quality control samples are out of range might not be valid. Do not report these data until you are certain that the instrument performs satisfactorily.
# Table of Contents

Copyright notice ................................................................................................... ii
Trademarks ............................................................................................................ ii
Customer comments ............................................................................................. ii
Contacting Waters ............................................................................................... iii
Safety considerations .......................................................................................... iii
  Considerations specific to the Q-Tof Premier mass spectrometer ................. iv
  Safety advisories............................................................................................... vii
Operating this system ........................................................................................ vii
  Intended use....................................................................................................... vii
  Calibrating ........................................................................................................ vii
  Quality control .................................................................................................. vii

1 Introduction ........................................................................................................ 1-1
  Overview ............................................................................................................. 1-2
  Hardware and software ................................................................................... 1-3
    Hardware configuration .................................................................................. 1-3
    Software configuration .................................................................................... 1-3
  Experimental design and use ......................................................................... 1-3
    Qualitative protein identification ................................................................ 1-3
    Qualitative identification and relative quantitation of proteins............... 1-4
    Qualitative identification and absolute quantitation of proteins............ 1-5
    Relative quantitation followed by identification........................................ 1-5
  Literature and further reading ..................................................................... 1-6

2 Setting up the system .................................................................................... 2-1
  nanoACQUITY UPLC system ......................................................................... 2-2
    nanoACQUITY UPLC system checklist ....................................................... 2-3
# Table of Contents

## Q-Tof Premier mass spectrometer setup .......................................................... 2-7
- Opening and creating a MassLynx project and tune file............................. 2-8
- Obtaining an ion beam .................................................................................. 2-10
- Factors affecting the ion beam ...................................................................... 2-12
- Tuning the mass spectrometer for optimal performance............................. 2-14
- RF settings and MS profile............................................................................ 2-18
- TDC settings and considerations .................................................................. 2-19

## Q-Tof Premier mass spectrometer calibration ........................................ 2-19
- Calibration solution ....................................................................................... 2-20
- Acquiring data for calibration....................................................................... 2-21
- Lock mass and lock mass correction............................................................. 2-22

## 3 System verification ................................................................................ 3-1
- Overview ............................................................................................................. 3-2
  - Columns............................................................................................................ 3-2
  - Column part numbers...................................................................................... 3-3
- nanoACQUITY UPLC system configuration ............................................... 3-4
  - Mobile phases and required solvents.............................................................. 3-4
- Samples ............................................................................................................... 3-5
- Loading the appropriate files ........................................................................ 3-5
- Conditioning the column .............................................................................. 3-10
- MS system configuration ............................................................................... 3-10
- LC-MS verification test – mass accuracy ................................................... 3-11
  - Expected performance levels......................................................................... 3-11
  - MS scan conditions ......................................................................................... 3-11
- LC-MS verification test – retention time precision ................................ 3-18
- Waters Protein Expression System verification test .............................. 3-19
  - Retention time and mass accuracy real-time quality control .............. 3-20
    - Setting up the OpenLynx method.......................................................... 3-21
    - Modifying the MassLynx sample list.................................................... 3-25
    - Running quality control............................................................................ 3-26
# Table of Contents

- Understanding failures ........................................................................................................... 3-27

4 Protein Expression Informatics ............................................................................................ 4-1

- Acquiring data and setting up expression analyses .............................................................. 4-2
- Protein Expression task flow .................................................................................................. 4-3
- Installing the software ........................................................................................................... 4-4
  - Installing PLGS software .................................................................................................. 4-4
  - Installing the Protein Expression license ......................................................................... 4-4
  - Sample data ...................................................................................................................... 4-4
- Starting the software ............................................................................................................... 4-5
- Software workflow .................................................................................................................. 4-5
  - Setting up projects ........................................................................................................... 4-5
  - Attaching and processing raw data .................................................................................... 4-7
  - Creating expression analysis experiments ......................................................................... 4-7
  - Viewing results ................................................................................................................... 4-9
  - Exporting results ............................................................................................................... 4-9

A Safety Advisories .................................................................................................................. A-1

- Warning symbols .................................................................................................................... A-2
  - Task-specific hazard warnings .......................................................................................... A-2
  - Warnings that apply to particular instruments, instrument components, and sample types .................................................................................................................. A-3

- Caution symbol ....................................................................................................................... A-5

- Warnings that apply to all Waters instruments ........................................................................ A-5

- Electrical and handling symbols ............................................................................................ A-12
  - Electrical symbols ............................................................................................................. A-12
  - Handling symbols .............................................................................................................. A-13

B Sample preparation .................................................................................................................. B-1

- Preparation of standard compounds ...................................................................................... B-2
  - Instrument tuning standards ............................................................................................... B-2
  - Lock mass reference standards .......................................................................................... B-2
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibration standards</td>
<td>B-2</td>
</tr>
<tr>
<td>Performance verification standard solutions (75-µm column)</td>
<td>B-3</td>
</tr>
<tr>
<td>LC/MS performance verification test standard</td>
<td>B-4</td>
</tr>
<tr>
<td>Protein Expression system performance verification standards</td>
<td>B-4</td>
</tr>
<tr>
<td>Performance verification standard solutions (300-µm column)</td>
<td>B-6</td>
</tr>
<tr>
<td>LC/MS Performance verification tests standard</td>
<td>B-6</td>
</tr>
<tr>
<td>Protein Expression system performance verification standards</td>
<td>B-6</td>
</tr>
<tr>
<td>Digestion procedures (solution phase and in-gel)</td>
<td>B-8</td>
</tr>
<tr>
<td>Considerations for sample digestion</td>
<td>B-8</td>
</tr>
<tr>
<td>RapiGest hydrolyzation process</td>
<td>B-12</td>
</tr>
<tr>
<td>C  Quick Start tutorial</td>
<td>C-1</td>
</tr>
<tr>
<td>Creating a PLGS project</td>
<td>C-2</td>
</tr>
<tr>
<td>Creating samples in Sample Manager</td>
<td>C-2</td>
</tr>
<tr>
<td>Creating a processing parameters template</td>
<td>C-3</td>
</tr>
<tr>
<td>Creating containers</td>
<td>C-3</td>
</tr>
<tr>
<td>Attaching and processing example raw data</td>
<td>C-3</td>
</tr>
<tr>
<td>Creating and running Protein Expression experiments</td>
<td>C-6</td>
</tr>
<tr>
<td>Performing a data bank search</td>
<td>C-6</td>
</tr>
<tr>
<td>D  Setting method parameter values</td>
<td>D-1</td>
</tr>
<tr>
<td>Changing MS scan time</td>
<td>D-2</td>
</tr>
<tr>
<td>Changing LC gradient length</td>
<td>D-2</td>
</tr>
<tr>
<td>Suggested method parameter values</td>
<td>D-2</td>
</tr>
<tr>
<td>E  Materials of Construction and Compliant Solvents</td>
<td>E-1</td>
</tr>
<tr>
<td>Items exposed to solvent</td>
<td>E-2</td>
</tr>
<tr>
<td>Common ingredients used to prepare mobile phases</td>
<td>E-3</td>
</tr>
<tr>
<td>Glossary</td>
<td>Glossary-1</td>
</tr>
</tbody>
</table>
1 Introduction

The Waters Protein Expression System investigates qualitative and quantitative proteomics, using an LC-MS exact mass based approach. These are the system’s main features:

• Post-processing software performs comprehensive analyses of tryptic peptides.

• Enhanced qualitative protein identification is performed simultaneously with relative quantitation across sample sets, enabling both the identification and characterization of potential biomarkers.

• Chemical labeling, such as isotopic (ICAT™, for example), isobaric (iTRAQ™, for example), or stable isotope labeling (O16, O18, for example), is not required.

Contents:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>1-2</td>
</tr>
<tr>
<td>Hardware and software</td>
<td>1-3</td>
</tr>
<tr>
<td>Software configuration</td>
<td>1-3</td>
</tr>
<tr>
<td>Experimental design and use</td>
<td>1-3</td>
</tr>
<tr>
<td>Relative quantitation followed by identification</td>
<td>1-5</td>
</tr>
<tr>
<td>Literature and further reading</td>
<td>1-6</td>
</tr>
</tbody>
</table>
Overview

The completion of the Human Genome Project has allowed the rapid identification of large numbers of human proteins using mass spectrometry in combination with bioinformatics. Similarly, other prokaryotic and eukaryotic genomes have enabled identification of proteins in simpler organisms. The separation of complex protein mixtures in large proteomic studies has most commonly been achieved by 2D-PAGE. However, advances in both liquid chromatography and mass spectrometry instrumentation have enabled the analysis of proteins that have not been separated on a two-dimensional gel.

These experiments involve separation of the complex digest mixture by microcapillary liquid chromatography connected to an instrument capable of data-directed analysis (DDA). In this case, the mass spectrometer identifies the peptide ions as they elute from the liquid chromatograph’s column and selects each precursor ion individually for MS/MS. Protein identification is then achieved through data bank searching of the ESI-MS/MS data, providing qualitative information on the proteins present. Hundreds of MS/MS spectra can be acquired in a fully automated fashion from a single LC/MS/MS experiment. This process results in the identification of significant numbers of proteins, including low copy number proteins.

A common goal of these experiments is the qualitative identification of proteins from simple or complex mixtures of biological origin. However, a significant problem, in either the gel-based or non-gel-based approach described above, is the ability to compare relative expression levels of identical proteins between samples. The DDA approach achieves this comparison using isotopic labeling.

This guide describes the implementation of a multiplexed approach to proteomics that is capable of both qualitative protein identification and relative quantitation, without labeling, across sample sets. During the course of an LC/MS run, the Q-Tof Premier mass spectrometer is programmed in MS\(^E\) mode to cycle between low and elevated collision energy acquisitions.

The resolution (10,000 FWHM in V-mode) and mass measurement accuracy (<3 ppm RMS) obtained from the Q-Tof Premier mass spectrometer are key in providing additional specificity for the analysis of complex tryptic digests, allowing confident protein identification. The chromatographic resolution and reproducibility of the nanoACQUITY UPLC\(^\circledR\) system (splitless nL flow rates) enable relative quantitative comparisons across large data sets.
Hardware and software

Hardware configuration

The Waters Protein Expression System is made up of the nanoACQUITY UPLC system coupled with the Q-Tof Premier mass spectrometer. In addition, chemistry and consumables are required to effect protein solubilization and digestion, as well as peptide separation. A list of chemistries and consumables appears in Appendix B.

Software configuration

Protein Expression requires ProteinLynx Global SERVER™ (PLGS) version 2.2 or later, along with a Waters Protein Expression System license. The information in this guide relates to PLGS version 2.3. For more specific information on installing and configuring PLGS consult the ProteinLynx Global SERVER 2.3 User’s Guide, and the release notes accompanying the product.

Experimental design and use

The Waters Protein Expression System performs many proteomic applications with a diverse range of sample types. The wide variety of applications required in proteomics dictates four modes of operation:

- Qualitative protein identification (see page 1-3)
- Qualitative identification and relative quantitation of proteins (see page 1-4)
- Qualitative identification and absolute quantitation of proteins (see page 1-5)
- Relative quantitation followed by identification (see page 1-5)

Qualitative protein identification

Using a simple LC-MS$^E$–based method we can identify peptides, and therefore proteins, in a sample. As the peptides elute during a LC run, the Q-Tof Premier mass spectrometer switches alternately (typically at 1-second
intervals) between low and elevated collision energies. The MS$^E$ spectra obtained at different collision energies are stored in separate functions.

During data acquisition, the quadrupole is not mass selective but rather operates in the radio frequency (rf) only mode, passing all ions to the gas cell. The first data function (MS) at low energy shows only the pseudo-molecular ions while the second, at elevated energy (MS$^E$) shows their associated fragments. At no point during the experiment are precursor ions selected using the quadrupole, as in the traditional product ion MS-MS acquisition (DDA). As a result this approach has a high-duty cycle, resulting in improved detection of peptides eluting from the LC system. This improved detection leads, in turn, to greater coverage of the amino acid sequence of the proteins present in the sample.

As the mass spectrometer continually alternates between low and elevated collision energy, all ions are passed to the oa-TOF for mass measurement. This results in the generation of exact-mass-measured fragment ions that can, potentially, be observed for every peptide precursor ion present in the low energy TOF data set. Therefore, the two acquired data functions contain the entire set of exact-mass-measured precursor and product ions formed by fragmentation within the collision cell. Using this system, sequence information can be simultaneously obtained for a large number of peptide species.

Bioinformatic processing of the acquired data detects the apex of each peptide ion identified in the low energy data function and identifies fragment ions in the elevated energy data occurring at the same retention time. Each precursor-fragments set is then searched against a data bank to identify the most likely protein identification, and those ions are then depleted so they have no influence on further identifications.

**Qualitative identification and relative quantitation of proteins**

The qualitative aspect of the experiment is performed as detailed in the section above. However, an added benefit of the high duty cycle in this experiment is that the chromatographic integrity of the peptide elution profile is maintained. This results in highly reproducible peptide ion intensities and peak areas from one experiment to the next, as this greater sampling rate translates into data points across the chromatographic peak.

Normalizing the data sets to a common endogenous or exogenous protein (digest) allows injection volume and MS response to be accounted for. Typically, each individual sample is analyzed in triplicate to obtain clear
statistical evidence for the presence of low-abundance ions. This analysis enables relative protein quantitation between two sample sets, without the requirement for stable isotope labeling.

**Qualitative identification and absolute quantitation of proteins**

The qualitative aspect of the experiment is performed as detailed in “Qualitative protein identification” on page 1-3. If your analysis includes the addition of a protein digest of known concentration, specifying the protein and its concentration enables the bioinformatics process to perform absolute quantitation on the other identified proteins.

**See also:** For details on how to set up absolute quantitation and view the results, see the *ProteinLynx Global SERVER 2.3 User’s Guide*.

**Relative quantitation followed by identification**

In certain instances, you might want to observe the relative quantitative differences between samples before proceeding to any further steps, such as peptide identification. You can do so by assigning an exact mass retention time (EMRT) signature to MS ions. Typically, each sample is analyzed in triplicate to obtain clear statistical evidence for the presence of ions that are identified from the software. This analysis enables relative quantitation between two or more sample sets at the peptide level.

This quantitation is performed without the requirement for stable isotope labeling. Using Expression Informatics software, LC-MS data sets are normalized to take into account typical errors in quantitative measurement (such as autosampler injection volume and mass spectrometer response).

Once components are identified—based upon their expression level differences—informatics tools within the Protein Expression System enable identification and validation, by using the EMRT selector tool and a subsequent database search.

**Acquiring data**

MassLynx™ acquires LC-MS\textsuperscript{E} data using the nanoACQUITY UPLC system and Q-Tof Premier mass spectrometer. This guide describes setup and verification of these instruments while the companion *ProteinLynx Global SERVER User’s Guide* describes the acquisition process.
Literature and further reading


720000870EN: The Waters Protein Expression System Brochure.

720000910EN: The Waters Protein Expression System Technical Note.


Waters Application Note 720002038EN; “Quantification of Diagnostic Markers and Pathway Analysis for Gaucher Disease by Means of LC-MS” by Hans Vissers, Jim Langridge, and Hans Aerts.

Poster ASMS 2006; “Metabolic and Proteomic Profiling of Cerebrospinal Fluid
and Serum for Schizophrenia” by Hilary Major, Thérèse McKenna,
Christopher Hughes, Johannes P.C. Vissers, Jeffrey T.J. Huang, Sabine Bahn,
Emanuel Schwarz, and Sven Nahnsen.

Waters Application Note 720001309EN; “The Use of Label-Free Expression
Profiling for the Detection of C-Reactive Protein in Human Serum” by Thérèse
McKenna, Chris Hughes, Mark Ritchie, Iain Campuzano and Jim Langridge.

Poster ABRF 2006; “Increased Proteomic Throughput and Productivity Using
a Simple LC/MS Platform” by C. A. Dorschel, J. C. Silva, G. Li, M. V.
Gorenstein, and S. J. Geromanos.

Poster ABRF 2006; “The Effect of Cold Shock on A.thaliana: A Proteomics
Study from Gel Separated Rosette Leaf Homogenates using Label Free
Quantitative LC/MS”, by M. Ritchie, H. Mock, S. Amme, J. Langridge, T.
McKenna.

Poster ABRF 2006; “Ischemia-Induced Changes in Protein Expression in Rat
and Mouse Brains” by M.D. Stapels, J.W. Finch, J.C. Gebler, M. Minami, and
A. Zhou.

Waters Application Note 720002039EN; “LC-MS Based Differential
Proteomics of the Mitochondria of [PSI+] and [psi-] Saccharomyces Cerevisiae
Strains” by Jacek Sikora, Chris Hughes, Hans Vissers, Thérèse McKenna, Jim
Langridge, Magdalena Boguta, and Michael Dadlez.

Waters Application Note 720002037EN; “Comparative LC-MS for
Quantitative Proteomics Analysis of Tomato-Fungus Interaction” by Twan
America and Hans Vissers.

Poster ABRF 2005; “A Systematic Study into the Reproducibility of HPLC and
Mass Spectrometry for the Analysis of Complex Protein Tryptic Digests by
LC/MS” by C. J. Hughes, J. Langridge, and T. McKenna.

Poster ASMS 2005; “The Effects of Osmotic Stress on Salmonella enterica
serovar Typhi: A Quantitative Proteomic Study” by Mark Ritchie, James
Langridge, Thérèse McKenna, Paul Skipp, David O’Connor, and Brian
Cochrane.

US Patent No. 6,717,130; “Methods and apparatus for mass spectrometry.”

US Patent No. 6,982,414; “Method of mass spectrometry and a mass
spectrometer.” Inventors: Robert Bateman, James Langridge, Thérèse
McKenna, Keith Richardson.
This chapter describes how to set up the Protein Expression system.

**Requirement:** Some knowledge and understanding of MassLynx is required. For more information on using MassLynx, refer to the *MassLynx Getting Started Guide* and the MassLynx online Help.

**See also:** *Q-Tof Premier Mass Spectrometer Operator’s Guide* and *nanoACQUITY UPLC System Operator’s Guide*.

**Contents:**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>nanoACQUITY UPLC system</td>
<td>2-2</td>
</tr>
<tr>
<td>Q-Tof Premier mass spectrometer setup</td>
<td>2-7</td>
</tr>
<tr>
<td>Q-Tof Premier mass spectrometer calibration</td>
<td>2-19</td>
</tr>
</tbody>
</table>
This section describes how to set up the nanoACQUITY UPLC system, as relevant for Protein Expression.

See also: *nanoACQUITY UPLC System Operator’s Guide*; MassLynx online Help.

Flow chart for nanoACQUITY UPLC system setup:
nanoACQUITY UPLC system checklist

Follow these steps to ascertain that the system is properly installed:

1. Ensure that nanoACQUITY UPLC system is assembled as it was after installation by a Waters field service engineer.

2. Place the nanoACQUITY UPLC system as close as possible on the left-hand side of the Q-Tof Premier mass spectrometer, so that the heating trapping module is close to the mass spectrometer source.

3. Make the electrical connections between the nanoACQUITY UPLC system and the Q-Tof Premier mass spectrometer (see the relevant operator’s guides for further details).

4. Turn on the nanoACQUITY UPLC system.

Obtaining MassLynx control

To obtain PC control of the system:

1. Power on the PC.

2. Make sure that MassLynx version 4.1 or later is installed.

   Tip: You can use the Protein Expression system with earlier versions of MassLynx. Refer to the Waters Protein Expression System Operator’s Guide, Revision A.

To configure MassLynx for the nanoACQUITY UPLC system:

1. In the main MassLynx window, click Inlet Method.

2. In the Inlet Method Editor click Tools > Instrument Configuration.

3. In the Inlet Configuration window, click Configure.

4. Work through the Inlet Configuration wizard, selecting Waters ACQUITY for the pump and autosampler. Select None for the detector.

5. Follow the wizard through to the finish.

6. In the Inlet Configuration window, click Events & Triggering.

7. In the Events & Triggering wizard follow the instructions, selecting 1 for Events In at the appropriate time.
8. In the Inlet Configuration window, click Finish.

Result: MassLynx is configured to control the nanoACQUITY UPLC system.

Inlet Configuration window:

Priming the pumps

⚠️ **Warning:** Use extreme care when working with formic acid. Perform all operations inside a fume hood, and wear appropriately protective goggles, gloves, and clothing.

These are the solvents used for Protein Expression:

- Solvent A – 99.9%:0.1% water/formic acid.
- Solvent B – 99.9%:0.1% acetonitrile/formic acid.

Prepare fresh solvents every 2 weeks.

For the Auxiliary Solvent Manager (used for LockSpray) prepare 200 fmol/µL [glu^1]-fibrinopeptide B in 25% acetonitrile/75% water containing 0.1% formic acid.
Tip: Prepare approximately 30 mL and place in a 50-mL measuring cylinder.

To prime the pumps:
1. In the MassLynx Inlet Editor, click Status.
2. Click the ACQUITY Additional Status tab.
3. Click to launch the ACQUITY UPLC® Console.

ACQUITY UPLC Console:
4. In the tree, click Binary Solvent Manager, and then click Control > Prime A/B solvents.
5. Prime the pumps for 2 to 5 minutes.
6. In the tree, click Auxiliary Solvent Manager, and then click Control > Prime A/B solvents.
7. Prime pump B for 1 minute.

To prepare the Sample Manager:
1. Refill the strong (99.9%:0.1% acetonitrile/formic acid) and weak (99.9%:0.1% water/formic acid) wash solvents.

2. In the ACQUITY Console tree, click Sample Manager, and then click Control > Prime syringes.

3. Click Control > Wash needle.

4. Close the ACQUITY UPLC Console.

**Sample Manager settings**

**To specify settings:**

**Requirement:** Ensure that your system is running with nanoACQUITY UPLC system firmware version 1.22 or later. If you are not sure how to do this, or if you need advice on upgrading, contact your local Waters representative.

1. In the MassLynx Inlet Editor, click Autosampler to launch the Sample Manager.

2. Select partial or full loop mode, depending on the sample amount and concentration. The needle placement can be adjusted as required for small sample volumes.

3. In the Sample Manager, click Advanced to access the advanced settings.

   **Tip:** All of the parameters in the Advanced Settings dialog box have been optimized for maximum sample recovery. The default values do not usually need to be altered.

**Tip:** When trapping a peptide digest use 100% solvent A. Hydrophilic peptides are not efficiently trapped if more than 1% organic solution is used during the trapping phase of the gradient.

**See also:** If you intend to alter the default values, refer to the *nanoACQUITY UPLC System Operator’s Guide* for further information.

**Connecting the injector valve to the column**

The provision of fittings for connecting the injector valve to the column depends on the type of chromatography being used:

- For 75-µm columns, the fittings are supplied with the column.
For 300-µm columns, use part number 700002757. This kit, which comes with the nanoACQUITY UPLC system startup kit, provides Rheodyne® valve fittings at one end and Valco® column fittings at the other.

See also: Refer to the nanoACQUITY UPLC System Operator’s Guide for information on connecting the injector valve.

The part numbers for columns recommended for use with the Waters Protein Expression System are provided on page 3-3.

Q-Tof Premier mass spectrometer setup

This section provides an overview of setting up the Q-Tof Premier mass spectrometer, as relevant to Expression.

See also: Q-Tof Premier Mass Spectrometer Operator’s Guide; MassLynx online Help.

Flow chart for Q-Tof Premier setup:

1. "Opening and creating a MassLynx project and tune file" on page 2-8
2. "Infuse sample of [glu₁]-fibrinopeptide B"
3. "Infuse sample of [glu₁]-fibrinopeptide B"
4. "Creating or open a project"
5. "Obtaining an ion beam" on page 2-10
6. "Tuning the mass spectrometer for optimal performance" on page 2-14
7. "Q-Tof Premier mass spectrometer calibration" on page 2-19
Opening and creating a MassLynx project and tune file

One of the two DVDs accompanying this document includes the Waters Protein Expression System template project (ProteinExpression_MS.pro).

MassLynx projects contain all the necessary files relating to a specific analysis. Your correct use of MassLynx projects enables you to use the instrument under varying conditions with all the files required for any type of sample analysis. You can store different configurations and operating parameters can be stored using a simple file structure. Projects contain all data acquired using the mass spectrometer.

You can build on the template project and customize it to your application. If you are setting up the Protein Expression system for the first time, you must create a project as described below. If a project has already been created, open that project and proceed to “Obtaining an ion beam” on page 2-10.

Prerequisites:

• Record the name and location of all your current Tune window files.

• In the Tune window, click Standby . Taking the instrument out of Operate mode prevents a new Tune window being opened with radically different voltage settings from those currently loaded.

To create a new project:

1. In MassLynx, click File > Project Wizard.

2. Click Yes to the warning message informing you certain services will be shut down.

3. In the Create Project dialog box, type a project name (MyExpression, for example), an optional description, and a file location.

4. Click Next.

5. Select “Create using existing project as template” and browse to the ProteinExpression_MS.pro project contained on the Protein Expression data DVD.
Create project dialog box:

6. Click Finish.

   **Result:** A new project folder with the name you specified (MyExpression.pro, for example) is created in the specified location. MassLynx opens this new project as the current project.

   **Tip:** An error message might appear stating that a sample list is invalid. If this is the case, click OK. MassLynx creates a blank sample list.

7. Copy your tune files to the new project’s Acqudb folder.

   **Important:** MassLynx online Help gives a full description of the MassLynx file structure; however, the Acqudb, Data, and Sampledb folders contain all the files necessary for this application.

**To open a tune file:**

1. On the MassLynx shortcut bar, click MS Tune to open the Tune window.

2. Click File > Open, navigate to the newly created project, and then open a relevant *.ipr file.

3. Using the location in the title bar of the Tune window, verify that the tune file is in the correct project.

4. Click the Operate button, to return the instrument to Operate mode.
Obtaining an ion beam

This section tells you how to make up and infuse a standard solution to determine whether the mass spectrometer produces a TOF ion beam. In most cases it will, and you can proceed to “Tuning the mass spectrometer for optimal performance” on page 2-14. However, if the instrument does not produce an ion beam, a troubleshooting guide helps you isolate and correct the cause of the problem.

Initial considerations

The following considerations apply:

- The sample must be filtered or centrifuged to avoid blocking the transfer line.
- Syringes must be thoroughly cleaned to minimize sample carryover.
- An appropriate tune file must be loaded.

Infusing a standard sample

To check for a beam:

1. In the Tune window, click Setup > Tuning Settings.
2. In the Tuning Setup dialog box, set the following values:
   - Data format to continuum
   - Scan time to 2.4 seconds
   - Inter-scan delay to 0.15 seconds
   - The start mass to 350 and the end mass to 1500
3. Click Update, and then click Close.
4. Infuse a 100 fmol/µL solution of [glu1]-fibrinopeptide B using a NanoFlow™ LC sprayer or a PicoTip® sprayer at 300 nL/min.

Result: Some response should be visible in the Tune window’s peak display.

If you see a signal in the Tune window, then you have a beam and should proceed to “Tuning the mass spectrometer for optimal performance” on page 2-14. Typical counts (displayed in the Tune window) for V-mode are 400 to 600 counts.
Ion beam display in Tune window when infusing [glu1]-fibrinopeptide B:

If there is no significant signal, continue with “Troubleshooting the absence of an ion beam” on page 2-12.
## Troubleshooting the absence of an ion beam

### Common things to check when no beam is present:

<table>
<thead>
<tr>
<th>Question</th>
<th>Causes and solutions</th>
</tr>
</thead>
</table>
| Does the Capillary voltage readback indicate voltage on the capillary?   | • Check that the high voltage cable is plugged in.  
  • Check that the source interlocks are secure. Check the source cable and all probe interlocks. On the Diagnostics page, the Source ID readback should be 2.7 V. A 10 V readback indicates an open interlock. |
| Do you have flow out of the probe tip?                                   | The easiest way to confirm flow is to look at the end of the probe with no capillary voltage or NanoFlow gas specified. A droplet should form.                                                                              |
| Looking at the camera display: do you see a spray, or is the liquid “blobbing”? | Check that the high voltage cable is plugged in.                                                                                                                                                                      |
| Is there voltage on the detector (MCPs)?                                | Check that the detector voltage is set to approximately 1800 to 2100 V. Needing to raise the detector voltage close to the maximum of 2400 V might indicate a problem. To contact Waters see “Contacting Waters” on page 1-iii. |
| Is the cone damaged or dirty?                                            | • Replace the cone if damaged.  
  • Clean the cone if dirty.                                                                                                                                                                                          |

## Factors affecting the ion beam

All the instrument tuning parameters are described in the *Q-Tof Premier Mass Spectrometer Operator’s Guide*. The factors described below are those that most effect this particular application.
Capillary voltage

Capillary voltage is usually optimized at 1.8 kV to 4 kV. Some samples might tune at values above or below this, depending on the emitter type. You should optimize the capillary voltage for maximum intensity, while also observing the background chemical noise level. Too low a capillary voltage can cause the loss of a beam.

Sprayer positioning

You can improve instrument sensitivity by optimizing the analyte sprayer probe position in relation to the sample cone/reference baffle.

Adjust the analyte sprayer position by manipulating the X-Y-Z probe stage. Take care not to position the analyte probe too close to the sample cone/reference baffle, as this baffle rotates every 20 to 30 seconds during an Expression acquisition to allow sampling of the reference solution.

For the analyte sprayer, a good starting position is 5 mm from the cone in both the x and y axes.

The probe position does not typically cause the beam to cut out, unless it is arcing to the cone or the NanoLockSpray™ baffle. However, if the sprayer is too close to the source there is a risk of grounding the spray voltage, and arcing could occur. If the sprayer is too far away, loss of the beam or reduction in its intensity could result.

Tip: If you are unsure whether arcing is taking place, dim the room lighting and look for an electric blue arc from the tip of the probe to the cone or NanoLockSpray baffle.

Sample Cone voltage

A cone setting of 26 V or less produces molecular ions with multiple charges for most sizes of tryptic peptide. Note that the cone voltage is a critical parameter: if you set it too high, you might observe fragmentation within the source.

Extraction Cone voltage

If you set the extraction cone voltage too high—typically to 2 V or more—peptide fragmentation is likely to occur within the source.
Source Temperature

Use a source temperature of 70 to 80°C at solvent flow rates of approximately 300 nL/min.

NanoFlow gas

To keep the liquid away from the probe tip and prevent it from wicking back into the probe, set the NanoFlow gas pressure to between 20 kPa (0.2 bar, 2.90 psi) and 50 kPa (0.5 bar, 7.25 psi).

Tip: NanoFlow gas does not nebulize the liquid flow and it is not always needed to produce an electrospray beam.

If there is no beam but you believe that solvent is flowing, increase the NanoFlow gas pressure to blow the probe tip clean. Then, return the gas setting to between 20 kPa (0.2 bar, 2.90 psi) and 50 kPa (0.5 bar, 7.25 psi).

Collision gas/Gas Cell pressure

The collision gas present in the collision cell—typically around $8 \times 10^{-4}$ kPa (8 × 10⁻⁶ bar, 1.16 × 10⁻⁴ psi)—is needed in both MS and high-energy MS modes to keep the ion beam focused, and induce fragmentation. The collision gas is always left on.

Detector Voltage

Over the lifetime of the MCPs, you might need to increase the voltage applied to them. Test the gain on the MCPs regularly, as described in the Q-Tof Premier Mass Spectrometer Operator’s Guide.

Tuning the mass spectrometer for optimal performance

Warning: Use extreme care when working with formic acid. Perform all operations inside a fume hood, and wear appropriately protective goggles, gloves, and clothing.

The previous section describes obtaining a TOF ion beam. However, a TOF ion beam is not the same as an optimized ion beam. You can optimize an ion beam for the following effects:

- Maximum resolution
• Maximum sensitivity
• A compromise between the ultimate limits of the instrument

Monitor the TOF beam in real-time while adjusting the instrument parameters to obtain the best performance.

**Recommendation:** Regularly save tune parameters.

When an experiment calls for ultimate resolution, the operator can load the known file and run the sample through the system to gain the required results. The maximum resolution tune file created by the Waters field service engineer on installation is a good starting point.

This section explains how to tune specifically for the following instrument conditions:

• Optimal resolution and sensitivity
• Limiting in-source fragmentation

These are the resolution and sensitivity specifications:

• Mode – V-mode
• Compound – \([\text{glu}^1]\)-fibrinopeptide B 100 fmol/\(\mu\)L; 25% acetonitrile v/v, 0.1% formic acid v/v
• Resolution (FWHM) – >10,000 at the doubly charged peak at 785.8426
• Sensitivity – >4000 counts at peak top in continuum mode. Ten 2.4 second scans combined.

These are the in-source fragmentation guidelines:

• Mode – V-mode
• Compound – Angiotensin II 200 fmol/\(\mu\)L; 25% acetonitrile v/v, 0.1% formic acid v/v
• Specification – Fragment ions <5% of the doubly charged base peak m/z 523.7751.

**Tip:** The most notable fragment peaks are 263.1395 and 784.4106.
Tuning flow diagram:

1. Infuse sample
2. Optimize Source ES parameters for maximum sensitivity
   - For best peak shape and resolution, optimize:
     - Pusher Offset
     - Pusher
   - Ion count: >400 per 2.4 second scan? (V)
     - No: Adjust capillary voltage
     - Yes: For best peak shape, resolution and sensitivity, optimize:
       - Acceleration1
       - Aperture 2
       - Transport1
       - Transport2
       - Steering
       - Ion count: >400 per 2.4 second scan? (V)
         - No: Adjust capillary voltage
         - Yes: Resolution achieved?
           - No
           - Yes: Finish
     - Yes
   - No: Adjust capillary voltage

Finish
To tune optimally for resolution and sensitivity:

1. Infuse a solution of \([\text{glu}^1]\)-fibrinopeptide B at 300 nL/min through the NanoFlow LC sprayer and into the analyte channel of the NanoLockSpray source.

2. Start a single acquisition as described in “Obtaining an ion beam” on page 2-10.

3. In the Spectrum window, right-click and combine across the peak at approximately 785.8 Da to generate a chromatogram.

4. Using the “Tuning flow diagram” on page 2-16, tune the mass spectrometer for optimum sensitivity and resolution.

5. Combine ten 2.4-second scans, and measure the resolution and sensitivity.

6. Click File > Save to save the tune file.

To tune for minimal in-source fragmentation:

In-source fragmentation is unavoidable when operating the instrument to analyze a diversity of peptides. You can, however, manage and minimize it.

1. Infuse a solution of angiotensin II at 300 nl/min through the NanoFlow LC sprayer and into the analyte channel of the NanoLockSpray source.

2. Start a single acquisition as described in “Obtaining an ion beam” on page 2-10.

3. Combine twenty 1.5-second scans.

4. In the Spectrum window, click Process > Smooth, and then enter the following parameters in the Spectrum Smooth dialog box.

**Spectrum Smooth parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smooth Window</td>
<td>4</td>
</tr>
<tr>
<td>Number of smooths</td>
<td>2</td>
</tr>
<tr>
<td>Smoothing Method</td>
<td>Savitsky Golay</td>
</tr>
</tbody>
</table>
5. Click Process > Center, and then enter the following values in the TOF Spectrum Center dialog box.

**TOF Spectrum Center parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min peak width at half height (channels)</td>
<td>4</td>
</tr>
<tr>
<td>Centroid top (%)</td>
<td>80</td>
</tr>
<tr>
<td>Create centered Spectrum</td>
<td>Areas</td>
</tr>
</tbody>
</table>

6. Ensure that the two fragment ions m/z 263.1395 and m/z 784.4106 are <2% of the intensity of the doubly charged parent ion at m/z 523.7751.

**Tip:** If the fragment ions are >5% of the intensity of the parent ion, there is too much source fragmentation. Reduce the cone voltage, extraction cone, and collision energy, and then repeat the procedure.

If there is still too much fragmentation, you might need to clean the whole source assembly. See the *Q-Tof Premier Mass Spectrometer Operator’s Guide* for full details of maintenance procedures.

7. Click File > Save to save the tune file.

**Important:** If parameters are changed, retune for sensitivity and resolution.

**RF settings and MS profile**

In the Tune window, click Setup > RF Settings.
RF Settings dialog box:

![RF Settings dialog box]

**RF settings**

The figure above shows Waters’ recommended settings for the ion guide and collision cell.

For more details, see the *Q-Tof Premier Mass Spectrometer Operator’s Guide*.

**MS profile**

The MS profile shown above is optimal for all experiments described in this document. For more details, see the *Q-Tof Premier Mass Spectrometer Operator’s Guide*.

**TDC settings and considerations**

The *Q-Tof Premier Mass Spectrometer Operator’s Guide* describes these settings in detail.

**Q-Tof Premier mass spectrometer calibration**

The MassLynx online Help and *Q-Tof Premier Mass Spectrometer Operator’s Guide* explain calibration in detail. This section describes Protein Expression system-specific settings.


**Calibration solution**

**Recommendation:** Use sodium cesium iodide mix for calibration.

**To prepare the calibration solution:**

1. Prepare both sodium iodide (NaI) and cesium iodide (CsI) to a concentration of 2 mg/mL in a 50% v/v solution of isopropanol.

2. Mix the two solutions to create a 1:19 CsI/NaI mixture, and infuse it into the instrument.

**Tip:** Noting the position of the sprayer, withdraw the sprayer stage until the counts are within the range that you require (for example, for an m/z of 1971.6, counts should be between 100 and 200 cps). Doing so results in a better spectrum than a less concentrated solution would (where the sprayer does not need to be withdrawn), and minimizes any possible chemical interference from background ions. Remember to move the sprayer back to its original position after calibration.

This calibration solution gives 15 calibration points over the m/z range 50 to 1990, according to the MassLynx calibration reference file ESI_NaICs_Pos.ref.

**Alternative:** You can substitute another calibration solution for NaICs as long as its reference points extend across the required mass range.

**Reference file**

You must obtain a calibration reference file that lists accepted calibrant masses. The reference files are text files, so you can create and edit them using any text editor, such as Notepad.

**Tip:** A semicolon must be present at the start of any line that includes a mass value not required for the calibration. MassLynx ignores mass values on lines that start with a semicolon.

The sodium iodide reference file contains 69 calibrant masses. Those in the m/z range 50 to 1990 are shown below.

<table>
<thead>
<tr>
<th>Mass</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>22.989768</td>
<td>100</td>
</tr>
<tr>
<td>132.905433</td>
<td>100</td>
</tr>
<tr>
<td>172.884013</td>
<td>100</td>
</tr>
<tr>
<td>322.778258</td>
<td>100</td>
</tr>
<tr>
<td>472.672503</td>
<td>100</td>
</tr>
<tr>
<td>622.566748</td>
<td>100</td>
</tr>
<tr>
<td>772.460993</td>
<td>100</td>
</tr>
</tbody>
</table>
Acquiring data for calibration

Data is acquired in a manner identical to that described in the *Q-Tof Premier Mass Spectrometer Operator’s Guide* and MassLynx online Help. This section describes variations in the standard procedure only.

After infusing the sodium cesium iodide mix and acquiring data over the appropriate m/z range, use the following parameters to smooth and center the data.

Smoothing parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>V-mode</th>
<th>W-mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smooth window (channels) ±</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Number of smooths</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Smoothing Method</td>
<td>Savitzky Golay</td>
<td>Savitzky Golay</td>
</tr>
</tbody>
</table>

Centering parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>V-mode</th>
<th>W-mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min peak width at half-height (channels)</td>
<td>4</td>
<td>7</td>
</tr>
<tr>
<td>Centroid top (%)</td>
<td>80</td>
<td>80</td>
</tr>
<tr>
<td>Create centered spectrum</td>
<td>Areas</td>
<td>Areas</td>
</tr>
</tbody>
</table>

Following smoothing and centering, you can calibrate the Q-Tof Premier mass spectrometer as described in the MassLynx online Help.
**Lock mass and lock mass correction**

**Recommendation:** For accurate mass work, keep the instrument in Operate mode at all times.

A typical reference solution used during a protein expression experiment is [glu$^1$]-fibrinopeptide B (m/z 785.8426), at a concentration of 200 fmol/µL.

Because the Expression experiment setup dialog box, LockMass tab, enables you to set one lock mass reference for peaks with multiple charges and another for peaks with single charges, the solution can also contain a singly charged reference compound, such as erythromycin (m/z 716.4585) at a concentration of 50 fmol/µL.

You can infuse the reference sample through the reference probe by the auxiliary solvent manager of the nanoACQUITY UPLC system, at 250 to 500 nL/min.

**Tips:**

- Best results are obtained if the lock mass gives an intensity of approximately 100 to 200 counts per second, as shown on the real-time tune display.
- Do not change TOF voltages without recalibrating the instrument.
- Always be aware of possible chemical interference problems, either on the sample or the lock mass peak.
This chapter explains how to verify performance of the LC-MS component of the Waters Protein Expression System, and then the performance of the entire system, including Protein Expression Informatics software.

You should perform the tests in this chapter periodically—ideally with every set of samples—to ensure that both the qualitative and quantitative results yield the most complete biological picture.

Contents:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>3-2</td>
</tr>
<tr>
<td>nanoACQUITY UPLC system configuration</td>
<td>3-4</td>
</tr>
<tr>
<td>Samples</td>
<td>3-5</td>
</tr>
<tr>
<td>Loading the appropriate files</td>
<td>3-5</td>
</tr>
<tr>
<td>Conditioning the column</td>
<td>3-10</td>
</tr>
<tr>
<td>MS system configuration</td>
<td>3-10</td>
</tr>
<tr>
<td>LC-MS verification test – mass accuracy</td>
<td>3-11</td>
</tr>
<tr>
<td>LC-MS verification test – retention time precision</td>
<td>3-18</td>
</tr>
<tr>
<td>Waters Protein Expression System verification test</td>
<td>3-19</td>
</tr>
<tr>
<td>Retention time and mass accuracy real-time quality control</td>
<td>3-20</td>
</tr>
</tbody>
</table>
Overview

The first tests described in this chapter examine both the retention time reproducibility of the nanoACQUITY UPLC system and the sensitivity and mass accuracy of the Q-Tof Premier mass spectrometer. The latter test examines the qualitative and quantitative output of the system for a complex protein digest mixture.

Two DVDs are provided, on which you can find the following items:

- User documentation.
- A template project containing sample lists, LC methods (75-µm and 300-µm chromatography), and the MS method.
- Zipped raw data files. When unzipped, these can be used as example data for processing with ProteinLynx Global SERVER (as practice for the processing of Protein Expression data files).
- Zipped PLGS project, which contains the workflow templates and processing parameters.

This chapter explains how to perform these tasks:

- Run a standard protein digest by LC-MS to test the LC and MS systems.
- Run mixtures of standard protein digests to test the Waters Protein Expression System.

**Important:** Before running these tests, ensure that the nanoACQUITY UPLC system and Q-Tof Premier mass spectrometer are installed as described in the relevant operator’s guides.

Columns

Three column types, specified below, are verified for use with the Waters Protein Expression System. Do not use other column types during the verification process.

- nanoACQUITY 75 µm × 150 mm Atlantis® 3 µm
- nanoACQUITY 300 µm × 150 mm Atlantis 3 µm
- nanoACQUITY 75 µm × 100 mm BEH™ 1.7 µm

The two 75-µm columns are used in combination with the nanoACQUITY 180 µm × 20 mm Symmetry® 5 µm Trapping Column, while the 300-µm column uses the direct injection method.
The process for configuration and verification is similar for all three column types. In the information that follows, differences between the columns are clearly indicated.

Waters BEH particles (1.7 µm) are designed specifically for use with Waters ACQUITY UPLC systems. Compared to columns packed with larger-size particles (3 µm or 5 µm), BEH columns offer the following benefits:

- Improved separation, resolution and sensitivity through reducing diffusion-related band broadening
- Higher peak capacities, narrower and more highly concentrated peaks, and more MS information

BEH columns also offer the potential to reduce the run time for the same resolving power.

Using BEH columns with the Waters Protein Expression system can help you achieve improved protein identification and quantification results.

**Column part numbers**

**Waters Protein Expression System column part numbers:**

<table>
<thead>
<tr>
<th>Column type</th>
<th>nanoACQUITY Phase 1 (5000 psi)</th>
<th>nanoACQUITY Phase 2 (10000 psi)</th>
</tr>
</thead>
<tbody>
<tr>
<td>75 µm × 150 mm Atlantis 3 µm</td>
<td>186002830</td>
<td>186003500</td>
</tr>
<tr>
<td>300 µm × 150 mm Atlantis 3 µm</td>
<td>186002836</td>
<td>186002836</td>
</tr>
<tr>
<td>75 µm × 100 mm BEH 1.7 µm</td>
<td>186002837</td>
<td>186003542</td>
</tr>
<tr>
<td>180 µm × 20 mm Symmetry 5 µm Trapping Column</td>
<td>186002841</td>
<td>186003514</td>
</tr>
</tbody>
</table>
Before starting any tests, ensure that the following tasks are performed:

- Pumps are primed
- Sample manager needle is washed

**Atlantis:** With the pump operating at 300 nL/min for 75-µm ID columns, or 4 µL/min for 300-µm ID columns, and the column connected the system, pressure should rise to more than 5516 kPa (55.16 bar, 800 psi) but less than 8274 kPa (82.74 bar, 1200 psi).

**BEH:** With the pump operating at 300 nL/min (at 97% A) and the column connected the system, pressure should rise to around 18616 kPa (186.16 bar, 2700 psi). The exact pressure observed varies from system to system.

Liquid should be observed at the column output. Any leaks detected in the flow path or column must be repaired before continuing.

See also: “nanoACQUITY UPLC system” on page 2-2.

**Mobile phases and required solvents**

⚠️ **Warning:** Use extreme care when working with formic acid. Perform all operations inside a fume hood, and wear appropriately protective goggles, gloves, and clothing.

- HPLC-grade water
- HPLC-grade acetonitrile
- Formic acid (analytical grade)

The following table lists the solvent compositions required for the nanoACQUITY UPLC system.

**Mobile phase compositions:**

<table>
<thead>
<tr>
<th>Mobile phase</th>
<th>75-µm and 300-µm i.d. chromatography</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>99.9% aqueous 0.1% formic acid</td>
</tr>
<tr>
<td>B</td>
<td>99.9% acetonitrile 0.1% formic acid</td>
</tr>
</tbody>
</table>
Sample manager wash

Weak: 99.9% aqueous 0.1% formic acid
Strong: 99.9% acetonitrile 0.1% formic acid

Samples

See Appendix B – “Sample preparation” for detailed sample preparation instructions.

NanoLockSpray reference solutions

200 fmol/µL [glu¹]-fibrinopeptide B (Sigma™ F3261), 50 fmol/µL erythromycin (Sigma E6376) in 25:75 acetonitrile/water + 0.1% formic acid.

Tip: If the ion counts are too low or too high, change the concentration of the reference solution accordingly. Alternatively, alter the flow rate of the auxiliary solvent manager (see “Priming the pumps” on page 2-4).

Enolase digest

Immediately before using it, prepare enolase tryptic digest 25 fmol/µL (part number 186002325) in aqueous 0.1% formic acid.

Loading the appropriate files

The Protein Expression system template project (see “Opening and creating a MassLynx project and tune file” on page 2-8) comes with all the files needed to verify the system’s performance.

The sample list references all the necessary files for the performance tests.
System verification sample list (SystemVerification_75um.spl):

<table>
<thead>
<tr>
<th>File Name</th>
<th>File Text</th>
<th>MS File</th>
<th>Inlet File</th>
<th>Bottle</th>
</tr>
</thead>
<tbody>
<tr>
<td>SysVer001</td>
<td>Blank injection</td>
<td>SysVer_45min</td>
<td>SysVer_LC_75um</td>
<td>1.1</td>
</tr>
<tr>
<td>SysVer002</td>
<td>Blank injection</td>
<td>SysVer_45min</td>
<td>SysVer_LC_75um</td>
<td>1.1</td>
</tr>
<tr>
<td>SysVer003</td>
<td>Blank injection</td>
<td>SysVer_45min</td>
<td>SysVer_LC_75um</td>
<td>1.1</td>
</tr>
<tr>
<td>SysVer004</td>
<td>Enolase 25 fmol/µL Chromatography Check</td>
<td>SysVer_45min</td>
<td>SysVer_LC_75um</td>
<td>1.2</td>
</tr>
<tr>
<td>SysVer005</td>
<td>Enolase 25 fmol/µL System Verification</td>
<td>SysVer_45min</td>
<td>SysVer_LC_75um</td>
<td>1.2</td>
</tr>
<tr>
<td>SysVer006</td>
<td>Enolase 25 fmol/µL System Verification</td>
<td>SysVer_45min</td>
<td>SysVer_LC_75um</td>
<td>1.2</td>
</tr>
<tr>
<td>SysVer007</td>
<td>Enolase 25 fmol/µL System Verification</td>
<td>SysVer_45min</td>
<td>SysVer_LC_75um</td>
<td>1.2</td>
</tr>
<tr>
<td>SysVer008</td>
<td>Enolase 25 fmol/µL System Verification</td>
<td>SysVer_45min</td>
<td>SysVer_LC_75um</td>
<td>1.2</td>
</tr>
<tr>
<td>SysVer009</td>
<td>Enolase 25 fmol/µL System Verification</td>
<td>SysVer_45min</td>
<td>SysVer_LC_75um</td>
<td>1.2</td>
</tr>
<tr>
<td>SysVer010</td>
<td>Blank injection</td>
<td>SysVer_120min</td>
<td>SysVer_LC_75um_140min</td>
<td>1.1</td>
</tr>
<tr>
<td>SysVer011</td>
<td>Blank injection</td>
<td>SysVer_120min</td>
<td>SysVer_LC_75um_140min</td>
<td>1.1</td>
</tr>
<tr>
<td>SysVer012</td>
<td>Mixture 1</td>
<td>SysVer_120min</td>
<td>SysVer_LC_75um_140min</td>
<td>1.3</td>
</tr>
<tr>
<td>SysVer013</td>
<td>Mixture 1</td>
<td>SysVer_120min</td>
<td>SysVer_LC_75um_140min</td>
<td>1.3</td>
</tr>
<tr>
<td>SysVer014</td>
<td>Mixture 1</td>
<td>SysVer_120min</td>
<td>SysVer_LC_75um_140min</td>
<td>1.3</td>
</tr>
<tr>
<td>SysVer015</td>
<td>Blank injection</td>
<td>SysVer_120min</td>
<td>SysVer_LC_75um_140min</td>
<td>1.1</td>
</tr>
<tr>
<td>SysVer016</td>
<td>Mixture 2</td>
<td>SysVer_120min</td>
<td>SysVer_LC_75um_140min</td>
<td>1.4</td>
</tr>
<tr>
<td>SysVer017</td>
<td>Mixture 2</td>
<td>SysVer_120min</td>
<td>SysVer_LC_75um_140min</td>
<td>1.4</td>
</tr>
<tr>
<td>SysVer018</td>
<td>Mixture 2</td>
<td>SysVer_120min</td>
<td>SysVer_LC_75um_140min</td>
<td>1.4</td>
</tr>
</tbody>
</table>

To load the appropriate files:

1. Ensure that the project ProteinExpression_MS.pro is loaded.
2. In the main MassLynx window, click File > Open, and choose one of the following sample lists:
   - SystemVerification_75um.spl for 75-µm Atlantis chromatography
   - SystemVerification_75um_BEH.spl for 75-µm BEH chromatography
   - SystemVerification_300um.spl for 300-µm Atlantis chromatography

nanoACQUITY UPLC system methods

Several nanoACQUITY UPLC system methods are supplied on the Protein Expression DVDs. The methods are used at various times during system verification.

The figures on the following pages illustrate the values set in the 75-µm methods. The gradients for 300-µm methods are identical except for the flow rate, which is set to 4 µL/min.

Rule: For system verification purposes, you should not change any of the values set in the methods provided.
75-µm column trapping settings:

![Image of trapping settings window]

**Rules:**

- The trapping settings shown above apply to all 75-µm column system verification methods.
- Because the injection method is direct for 300-µm chromatography, Trapping Pump is set to None.
30-minute gradient method for 75-µm Atlantis columns (SysVer_LC_75um):

This method is used for mass accuracy and retention time precision verification with Atlantis 75-µm columns.

90-minute gradient method for 75-µm Atlantis columns (SysVer_LC_75um_140mins):

This method is used for system performance verification with Atlantis 75-µm columns.
30-minute gradient method for 75-µm BEH columns (SysVer_LC_75um_BEH):

This method is used for mass accuracy and retention time precision verification with BEH 75-µm columns.

60-minute gradient method for 75-µm BEH columns (SysVer_LC_75um_90min_BEH):

This method is used for system performance verification with BEH 75-µm columns.
Conditioning the column

**To condition the trap:**

For its initial use, condition the sample trap by flushing at 4 µL/min at 80% B for 1 hour. Ensure that the trap valve is open, and the flow is directed to waste during flushing.

**To condition the column:**

1. Place a vial of 50 µL 0.1% formic acid in sample position 1:1.
2. Right-click in the Inlet File cell of the sample list and open the appropriate method:
   - SysVer_LC_75um for 75-µm Atlantis or BEH chromatography
   - SysVer_LC_300um for 300-µm Atlantis chromatography
3. Highlight the first three lines of the sample list and click Start.

**MS system configuration**

Before continuing with performance verification, check the system configuration.

**To check the MS system configuration:**

1. Ensure the mass spectrometer is still performing to its specifications, as described in Chapter 2 – “Setting up the system”.
2. Ensure the Auxiliary pump is primed with the lock mass reference solution.
3. In the Tune window, change the LockSpray to the reference sprayer.
4. Ensure there is a stable signal of between 100 and 200 counts per second for [glu¹]-fibrinopeptide B at m/z 785.8426 and erythromycin at m/z 716.4585.
5. Check that the output of the column is connected to the sprayer input on the MS.

**See also:** nanoACQUITY UPLC System Operator’s Guide and Q-Tof Premier Mass Spectrometer Operator’s Guide.

**LC-MS verification test – mass accuracy**

**Rule:** The solutions referred to in this section apply only to 75-µm chromatography. For 300-µm chromatography use the samples described in “Performance verification standard solutions (300-µm column)” on page B-6.

**Expected performance levels**

**Atlantis:** The test should achieve an RMS mass accuracy, for the seven selected peptides, of 5 ppm or better, with the BPI of the selected peptides being above 1000 counts per 1.5-second scan. Half-height chromatographic peaks are typically between 0.15 and 0.2 minutes wide (see “BPI chromatogram of enolase tryptic digest – Atlantis” on page 3-13).

**BEH:** The test should achieve an RMS mass accuracy, for the seven selected peptides, of 5 ppm or better, with the BPI of the selected peptides being between 500 and 1000 counts per 0.6-second scan. Half-height chromatographic peaks are typically between 0.08 and 0.15 minutes wide (see “BPI chromatogram of enolase tryptic digest – BEH” on page 3-14).

**MS scan conditions**

With Atlantis columns the LC-MS experiment uses the MS file SysVer_45min.exp, with the settings shown below.

**Atlantis MS method conditions:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start time (min)</td>
<td>5</td>
</tr>
<tr>
<td>End time (min)</td>
<td>45</td>
</tr>
<tr>
<td>Run Time (min)</td>
<td>45</td>
</tr>
<tr>
<td>Mass Range (m/z)</td>
<td>50 to 1990</td>
</tr>
<tr>
<td>Scan Time (secs)</td>
<td>1.5</td>
</tr>
<tr>
<td>InterScan Delay</td>
<td>0.09</td>
</tr>
</tbody>
</table>
Atlantis MS method conditions:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Format</td>
<td>Continuum</td>
</tr>
<tr>
<td>Ramp High Energy (V)</td>
<td>15 to 40</td>
</tr>
<tr>
<td>Low Energy (V)</td>
<td>4</td>
</tr>
<tr>
<td>Cone Voltage (V)</td>
<td>Use Tune page</td>
</tr>
<tr>
<td>Reference Scan Frequency (secs)</td>
<td>30</td>
</tr>
<tr>
<td>Reference Scan Cone Voltage (V)</td>
<td>28</td>
</tr>
</tbody>
</table>

With BEH columns the LC-MS experiment uses the MS file SysVer_45min_BEH.exp, with the settings shown below.

BEH MS method conditions:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start time (min)</td>
<td>10</td>
</tr>
<tr>
<td>End time (min)</td>
<td>45</td>
</tr>
<tr>
<td>Run Time (min)</td>
<td>45</td>
</tr>
<tr>
<td>Mass Range (m/z)</td>
<td>50 to 1990</td>
</tr>
<tr>
<td>Scan Time (secs)</td>
<td>0.6</td>
</tr>
<tr>
<td>InterScan Delay</td>
<td>0.09</td>
</tr>
<tr>
<td>Data Format</td>
<td>Continuum</td>
</tr>
<tr>
<td>Ramp High Energy (V)</td>
<td>15 to 40</td>
</tr>
<tr>
<td>Low Energy (V)</td>
<td>4</td>
</tr>
<tr>
<td>Cone Voltage (V)</td>
<td>Use Tune page</td>
</tr>
<tr>
<td>Reference Scan Frequency (secs)</td>
<td>30</td>
</tr>
<tr>
<td>Reference Scan Cone Voltage (V)</td>
<td>38</td>
</tr>
</tbody>
</table>
To run the LC-MS test - enolase tryptic digest:

1. Place 50 µL of enolase tryptic digest (25 fmol/µL) in position 1:2 of the sample manager.

2. Highlight sample 4 from the sample list. This first injection is used to check the chromatographic performance. The sample list specifies that each injection is 2 µL.

3. Click to start the acquisition.

4. When the run ends, click Chromatogram on the Sample List menu bar.

5. In the Chromatogram window, click Display > TIC.

6. Select BPI Chromatogram in the TIC Chromatogram dialog box. The chromatogram displayed looks similar to those shown below, when 75-µm columns are used.

BPI chromatogram of enolase tryptic digest – Atlantis:
Extracting LC retention time and mass data

**Requirement:** The RMS ppm mass errors on 7 peptides from an enolase tryptic digest should be 5 ppm or less.

Reconstructed ion chromatograms for each of the following peptides (listed in the order they elute) should be generated when a chromatogram is opened:

- m/z 580.3095
- m/z 708.8650
- m/z 404.2222*
- m/z 644.8595*
- m/z 643.8593*
- m/z 878.4785
- m/z 789.9047
Tip: The peptides indicated with asterisks (*) are likely to be the most stable, and therefore most suitable for monitoring.

Two enolase peptides are close in mass, but not in elution time. These are m/z 644.8595—which elutes first—and m/z 643.8593, which elutes second. When reconstructed ion chromatograms are generated for these two ions, two chromatographic peaks appear in the 644.8595 reconstructed ion chromatogram. The first chromatographic peak represents ion m/z 644.8595. The second chromatographic peak corresponds to the third isotope of the ion, m/z 643.8593.

Measure and record the signal intensity (at the peak top) and the peak width at half-height for each of the peptides in the SysVer.xls spreadsheet.

To mass measure each peptide:

1. To open the combined spectrum for a peptide, in the Chromatogram window right-click and drag across the peptide peak at half-height.

Spectrum of an eluted peptide:

2. Click Process > Mass Measure. Typical parameters are shown below.
Mass Measure parameters:

**Important:** Use the same centroid and smoothing parameters that you used during the instrument calibration to mass measure this data.

3. Click TOF and set the TOF parameters. Typical parameters are shown below.
TOF Accurate Mass parameters:

**Tips:**

- The resolution should be the value measured in “Tuning the mass spectrometer for optimal performance” on page 2-14.
- The lock mass shown here is for [glu$^1$]-fibrinopeptide B.

4. Click OK; then click OK again to start the mass measurement process.

The accurate mass measurements are taken from the smoothed, centroided, and lock mass–corrected spectrum.
5. Record the values in the spreadsheet (SysVer.xls) provided in the ProteinExpression_MS project. The spreadsheet automatically calculates the RMS-ppm error values for the peptides.

**LC-MS verification test – retention time precision**

To run the system retention time precision test:

1. Select samples 5 to 9 inclusive from the System Verification sample list.

2. Click \( \rightarrow \) to start the acquisition.

**Specification:** The standard deviations (SD) of the retention times on five repeat injections should be 0.25 minutes or less. The ppm mass errors, peak widths, and peak intensities should be comparable to those specified in “LC-MS verification test – mass accuracy” on page 3-11.
Measure the repeatability of the system by making five 2-µL repeat injections of enolase tryptic digest (25 fmol/µL).

- Mass chromatograms for the peptides in each sample should be generated as described in the previous section, and the results recorded in the system verification spreadsheet.
- The ppm mass errors and the SDs of the retention times for every run for each peptide are calculated in the spreadsheet.

Once the performance verification requirements have been met, proceed to “Waters Protein Expression System verification test” on page 3-19.

**Waters Protein Expression System verification test**

**To run the system test:**

1. Make up two MassPREP digestion standard (MPDS) mixtures, as detailed in Appendix B.

2. Place 50-µL aliquots of each into separate vials, and place them in positions 1:3 and 1:4 on the autosampler.

3. Ensure that the following conditions are met:
   - Both the analyte and LockSpray sprayers are functioning.
   - There is sufficient lock mass solution for at least 24 hours.
   - At least 30 GB of hard drive space is available on the instrument PC.

4. Select samples 10 to 18 inclusive in the sample list.

5. Click to start the acquisition.

**Result:** Two Protein Expression experiments run, each in triplicate, along with three blanks. Each experiment runs for approximately 2 hours.

**Specification:** Four proteins, from two protein digest mixtures (Mix 1 [part number 1860002865] and Mix 2 [part number 1860002866]), should be detected and identified in the samples. Quantitative comparisons should also be made between the samples.

See Chapter 4 – Protein Expression Informatics for details about how to process the data.
Criteria for acceptance

Rule: None of the following criteria apply to alcohol dehydrogenase, because it is the internal standard against which Mix 1 and Mix 2 are normalized.

- Spiked proteins must be qualitatively identified in the higher samples prior to relative quantification measurement.
- The relative concentration ratio of the spiked protein digest mixtures should be measured with an error not exceeding ±15%.
- The relative concentration ratio of the spiked protein digest mixtures should be measured with a probability of up-regulation of either 0.0 or 1.0.

Acceptable ratio ranges:

<table>
<thead>
<tr>
<th>Protein mixture</th>
<th>Verification acceptance range, Mix2:Mix1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alcohol dehydrogenase</td>
<td>Internal standard</td>
</tr>
<tr>
<td>Glycogen phosphorylase B</td>
<td>0.4 to 0.6</td>
</tr>
<tr>
<td>Enolase</td>
<td>1.7 to 2.3</td>
</tr>
<tr>
<td>Bovine serum albumin</td>
<td>6.8 to 9.2</td>
</tr>
</tbody>
</table>

Note: The verification acceptance ranges are rounded to the nearest tenth.

Retention time and mass accuracy real-time quality control

During an acquisition, you can run quality control checks using OpenLynx. The OpenLynx QC method determines whether the following parameters are within acceptable thresholds, and pauses the acquisition if problems are found.

- Retention time
- Peak area
- Mass accuracy
- Ion intensities

There are two steps to configuring OpenLynx quality control: setting up the OpenLynx method and modifying the MassLynx sample list.
Prerequisite: OpenLynx must be installed. You can install it at any time. Refer to the MassLynx Getting Started Guide for further information.

Recommendation: Run the quality control tests against enolase tryptic digest (25 fmol/µL × 2 µL). Other peptide standards can be analyzed for quality control, but the supplied OpenLynx method will need appropriate alterations.

Setting up the OpenLynx method

To open the method:

1. In MassLynx, click the OpenLynx tab on the left-hand side of the MassLynx bar.
2. Click Setup.
3. If you are asked whether you want to configure OpenLynx, click No.
4. Click File > Open.
5. On the sample projects DVD, browse to the file QC_Expression.olp, and then click Open.
6. Click View > Options.
7. Select Chromatogram Test, Quality Control, and Mass Measure. Clear all other boxes.
8. Click OK.
OpenLynx method editor:

To set the lock mass:

1. Click the MS Process tab.
2. In the Mass Measure MS Data section, click Settings (MS+).
3. At the bottom of the Mass Measure dialog box, click TOF.
4. In the Lock Mass Correction section, type the appropriate lock mass, and check that the mass window value is appropriate.
5. Click OK, and then OK again to return to OpenLynx setup.
To set retention time and peak area parameters:

1. Click the Quality Control tab.
2. Ensure that QC Required is selected, and that MS TIC+ is selected in the Traces list.
3. Ensure that the preset +/- R.T. value (0.3), which indicates how much retention times can vary and still be considered acceptable, is appropriate for your experiment.
4. Ensure that the +/- Peak Area value (4), which indicates how much the areas of the peaks of interest can vary and still be considered acceptable, is appropriately set.
5. Click Stream 1.
6. In the Stream Parameters dialog box, click any cell you want to modify and type a new value.

Tip: This dialog box specifies the expected retention time, area, and intensities of the ions used for quality control.
Stream Parameters dialog box:

Tip: OpenLynx integrates all peaks found within the retention time window, and calculates the percentage area of each peak relative to the total peak area.

To check the areas for the ions of interest, run the OpenLynx method and view the results in the OpenLynx browser. See “Running quality control” on page 3-26 for details.

7. Click OK.

To set ion intensity parameters:

1. Click the Spectrum Test tab.
2. Ensure the Threshold Mode is set to Absolute.
3. Set the Threshold and Confirmation Threshold. Threshold is the minimum ion intensity for a peak to be considered found. Confirmation Threshold is the minimum ion intensity for a peak to be considered a good match.

Recommendation: Leave these values at their current settings, unless you know from experimentation that the thresholds are too high or low.
4. In the Accurate Mass Error Reporting section, set the Primary and Secondary thresholds. These settings determine the maximum difference from the specified accurate mass that each peak will be permitted to be considered found (Primary) or to be considered a good match (Secondary).

**Recommendation:** Leave these values at their current settings, unless you know from experimentation that the thresholds are too high or low.

**Other parameters**

A number of other parameters are important for the success of OpenLynx quality control tests. These parameters are already set in the example file and, if enolase tryptic digest (25 fmol/µL × 2 µL) is used, do not usually need changing. For reference the basic requirements of any method are outlined below.

- Start and end times should encompass all the peptides of interest.
- BPI chromatograms should be produced, MS spectra should be reported, and all detected peaks should be used.
- Spectra should be averaged around the peak top.
- Chromatogram testing should be enabled for BPI chromatograms, and an appropriate threshold set.

**Modifying the MassLynx sample list**

Waters recommends that the quality control sample be run regularly throughout acquisitions, so that the acquisition is suspended quickly if the system deviates from expected standards.

For each quality control sample, several additional columns must be added to the sample list and appropriately set. See the MassLynx online Help for information on how to add and modify columns in the sample list.

**Recommendation:** Run the quality control tests against enolase tryptic digest (25 fmol/µL × 2 µL). Other peptide standards can be analyzed for quality control, but the sample list will need appropriate alterations.

These are the columns required for each quality control sample:

- Parameter File (PROCESS_PARAMS)
- Process (PROCESS)
- Sample Type (TYPE)
• Action on Error (PROCESS_ACTION)

Additionally, a column must be included for each of the accurate masses of the peptides against which you want to perform the quality control check:

• Mass A (MASS_A)
• Mass B (MASS_B)

... 
• Mass n

**Tip:** Column names are configurable, so they can differ from those given above. The field IDs (given in brackets above) remain the same whatever the name of the column.

When using enolase tryptic digest, you should set the additional columns for each quality control sample as described in the following table.

### Quality control sample list settings:

<table>
<thead>
<tr>
<th>Column</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter file</td>
<td>QC_Expression.olp</td>
</tr>
<tr>
<td>Process</td>
<td>OpenLynx</td>
</tr>
<tr>
<td>Sample Type</td>
<td>QC</td>
</tr>
<tr>
<td>Mass A</td>
<td>404.2222</td>
</tr>
<tr>
<td>Mass B</td>
<td>643.8593</td>
</tr>
<tr>
<td>Mass C</td>
<td>644.8595</td>
</tr>
<tr>
<td>Action on Error</td>
<td>Suspend All Batches</td>
</tr>
</tbody>
</table>

**Running quality control**

You must include your quality control samples in the sample list used for acquisition, as described in “Modifying the MassLynx sample list” on page 3-25. Also, make the enolase tryptic digest (or other solution) available to the instrument in the appropriate vials.

Once included, start acquisition in the normal way, ensuring that Auto Process Samples is selected in the Start Sample List Run dialog box. For more information on starting acquisitions, refer to the MassLynx online Help.
The quality control samples run automatically as part of the acquisition process, and the results are compared against the acceptance criteria specified in the OpenLynx method.

Depending on the outcome of the quality control comparison, the acquisition will either continue or pause.

**Outcomes of quality control test:**

<table>
<thead>
<tr>
<th>Result of test</th>
<th>Effect on acquisition</th>
</tr>
</thead>
<tbody>
<tr>
<td>All the peaks are found, with acceptable retention times, areas, masses, and intensities.</td>
<td>Acquisition continues.</td>
</tr>
</tbody>
</table>
| One or more of the peaks is found with acceptable retention time and area, but with one of the following conditions:  
  • Intensity between the minimum and confirmation intensity thresholds.  
  • Mass accuracy between the primary and secondary thresholds.  
  Other peaks fulfill all criteria. | Acquisition continues. |
| Some, but not all, of the peaks are found with acceptable retention times, areas, masses, and intensities. | Acquisition is paused. |
| None of the peaks are found with acceptable retention times, areas, masses, and intensities. | Acquisition is paused. |

**Understanding failures**

If an acquisition run is suspended due to a quality control test failure, you can view the results of the relevant test.

Each quality control sample creates an OpenLynx report file (*.rpt) containing the results of the test.

**To view OpenLynx results:**

1. In MassLynx, click the OpenLynx tab on the left of the MassLynx bar.

**Tip:** The thresholds are specified in the OpenLynx method editor, Spectrum Test tab. See “Setting up the OpenLynx method” on page 3-21.
2. Click Browser.

3. Click File > Open.

4. Browse to the report file with the file name associated with the sample of interest, and then click Open.

The results show whether the peaks specified in the OpenLynx method were found. They also provide accompanying information such as retention time and peak area.

Use this information to determine what type of problem has occurred. If no problem has actually occurred, but the test has failed, use the information to make appropriate modifications to the OpenLynx method so that the requirements for success are less strict.
This chapter describes how to install and use the software.

See also: Appendix C – “Quick Start tutorial” gives a step-by-step guide to setting up a simple expression analysis experiment in ProteinLynx Global SERVER, using the example data provided.

Contents:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acquiring data and setting up expression analyses</td>
<td>4-2</td>
</tr>
<tr>
<td>Protein Expression task flow</td>
<td>4-3</td>
</tr>
<tr>
<td>Installing the software</td>
<td>4-4</td>
</tr>
<tr>
<td>Starting the software</td>
<td>4-5</td>
</tr>
<tr>
<td>Software workflow</td>
<td>4-5</td>
</tr>
<tr>
<td>Viewing results</td>
<td>4-9</td>
</tr>
<tr>
<td>Exporting results</td>
<td>4-9</td>
</tr>
<tr>
<td>For details of how to print and export your results, refer to the ProteinLynx Global SERVER User's Guide.</td>
<td>4-9</td>
</tr>
</tbody>
</table>
Acquiring data and setting up expression analyses

Prerequisites:

- Installation media.
- Any previous versions of ProteinLynx Global SERVER (PLGS) must be uninstalled before installing PLGS 2.3 and the Protein Expression license.
- Some knowledge of the PLGS, particularly the Expression Analysis tool. In-depth knowledge is not required.

MassLynx acquires LC-MS\textsuperscript{E} data by using the nanoACQUITY UPLC system and Q-Tof Premier mass spectrometer. This guide describes setup and verification of these instruments while the companion ProteinLynx Global SERVER User’s Guide describes the acquisition process.

Expression experiments are largely set up, and their results viewed, within PLGS. Refer to the ProteinLynx Global SERVER User’s Guide for comprehensive assistance in the installation, setup, and use of the software.
Uninstall previous versions of PLGS, and then install PLGS 2.3 and the Protein Expression license. See: “Installing the software” on page 4-4. “Starting the software” on page 4-5.

- Create project
- Create samples
- Create containers
- Create templates
- Import and process raw data
- Setup Expression experiments
- Select samples
- Group samples
- Complete setup
  - Quantify data
  - Protein ID / EMRT quantitation
  - Cluster data
  - Results table

Clipboard
Disk
Installing the software

Protein Expression software consists of two components:

• ProteinLynx Global SERVER 2.3.
• Protein Expression License.

Rule: You must install the PLGS software before the Protein Expression License.

See also: The Expression features, and results generated, are available through the ProteinLynx Global SERVER browser. For full details on configuring and controlling PLGS see the ProteinLynx Global SERVER Version 2.3 User’s Guide.

Installing PLGS software

The ProteinLynx Global SERVER Version 2.3 User’s Guide gives full details of the installation procedure for PLGS.

Installing the Protein Expression license

Rule: You need to install the Protein Expression license only on the Windows PC on which you set up and initiate your expression experiments. No changes are necessary for other computers in your PLGS system.

To install the Expression license:

1. Browse to ExpressionLicense.exe on your Expression DVD.
2. Double-click ExpressionLicense.exe.
3. Follow the on-screen instructions.

Result: Your ProteinLynx Global SERVER installation is now fully enabled for Expression Analysis setup.

Sample data

Waters provides two DVDs containing raw sample data, and a PLGS project containing workflow templates and processing parameters. You can use them for training purposes.
Starting the software

To access the Protein Expression features, click Start > All Programs > ProteinLynx 2.3 > ProteinLynx Browser.

**Prerequisite:** The PLGS microkernel, search engine, and processor engine must be running. They will start automatically when PLGS runs on a single Windows machine. However, for systems with remote processors, you must start the software manually. See the *ProteinLynx Global SERVER User’s Guide* for details.

Software workflow

You can use Protein Expression to perform label-free protein expression experiments. However, before you can perform these experiments, you must set up a project, and import and process raw data.

**Expression software setup workflow:**

1. Set up a project. You create a project, samples, containers, and templates.

2. Import and process the raw data acquired using MassLynx.

3. Perform experiments. You can perform three types of experiment:
   - Protein identification.
   - EMRT quantitation – to detect EMRT (Exact Mass Retention Time) clusters and derive expression ratios for those clusters.
   - Protein identification quantitation – to derive expression ratios for identified proteins.

The following sections describe the processes for each step in the workflow.

Setting up projects

Before you import and process raw data, or perform any experiment, you must create objects in PLGS that are used to store data. These objects are projects, samples, and containers. The following steps set up a project ready to accept raw data:

1. Setup PLGS preferences.
2. Create a new project.

3. Use Sample Manager to
   a. create samples.
   b. annotate the samples.

4. Use Container Manager to
   • create new containers, and add samples to those containers, or
   • import a list containing the samples to be processed.

5. Create a processing parameters template using the Data Preparation tool.

6. Create a workflow template using the Workflow Designer.

ProteinLynx Global SERVER User’s Guide provides extensive instructions on each of these steps. For some of the steps, useful Expression-related advice appears below.

**Setup PLGS preferences**

On the Instrument tab of the Preferences dialog box (ProteinLynx browser > Options > Preferences), set the default instrument type to Q-Tof.

**Creating samples**

Samples must be created in Sample Manager before an expression analysis experiment can be performed. As well as enabling you to track information throughout projects, samples also help to identify ratios of interest in some experiments. Use names for the samples that help you to identify them when performing experiments.

**Creating processing parameters templates**

A processing parameter template contains parameters used by the data processing algorithms to generate EMRT (Exact Mass Retention Time) entities and fragment ion data.

The Data Preparation tool enables you to create custom processing parameters, which are attached to raw data before processing. Processing parameters templates determine how the raw data is processed and whether certain attributes (for example, chromatographic peak widths) are considered.
The acquisition types applicable to Protein Expression are Electrospray-MS and Electrospray-MS$^E$. The Electrospray-MS option generates a template that describes processing of low-energy data only, while an Electrospray-MS$^E$ template describes processing of both low and elevated energy (MS$^E$).

**Creating workflow templates**

The search types applicable to Protein Expression are Electrospray-MS and Electrospray-MS$^E$. The Electrospray-MS option enables searching of low-energy data only: effectively a peptide mass fingerprint. The Electrospray-MS$^E$ option enables searching of both the low- and elevated-energy fragment data (MS$^E$).

For Protein Expression, data bank searching is the only applicable search method.

In the Fixed Modifications attribute of the data bank search query that you create, select Carbamidomethyl C.

**Attaching and processing raw data**

Once you set up your project (see “Setting up projects” on page 4-5), you can attach raw data to vials or spots and process them. The process of acquiring Expression (MS$^E$) raw data through MassLynx is described in the *ProteinLynx Global SERVER User’s Guide*.

**Tip:** If you imported a sample list into ProteinLynx Global SERVER, you need not attach raw data manually because the sample list specifies the data to use.

The Container Manager section of *ProteinLynx Global SERVER User’s Guide* provides extensive instructions on the steps required to attach and process data.

**Creating expression analysis experiments**

In ProteinLynx Global SERVER you can create expression analysis experiments and view their results.

In addition to all the types of experiment that can be created as standard in PLGS, you can create label-free experiments if you have a Protein Expression
system license. The license enables you to create and run qualitative and quantitative experiments on samples without isotope labels.

**Creating label-free experiments**

The *ProteinLynx Global SERVER User’s Guide* details the process of setting up an expression analysis experiment. This section contains information on the additional feature available only with a Protein Expression license.

The second step of setting up an expression analysis is titled Select Grouping Method. In this step, you specify which samples you want grouped together for comparison. You can choose to put each sample in a separate group, to group the samples by an attribute (including a custom attribute), or to manually specify which groups samples should be placed in.

Without a Protein Expression license, only isotope-labeled samples can be included in the analysis. Then, only if there are more than two samples in the isotope-labeled processed sample—typically when the sample is isobaric—can you use any grouping method other than putting each sample in a separate group.

If the Protein Expression license is installed you can clear the “Use isotope-labelled sample” box, and group your samples however you choose.

**Grouping of label-free samples:**

![Image of ProteinLynx Global SERVER User’s Guide](image-url)
Internal standards and normalization

Later in the expression analysis setup comes the Quantitation Analysis step. In this step, select as internal standards a Protein ID or three EMRT clusters that have 100% coverage. When generating an EMRT table, choose one cluster with a low retention time, one with a medium retention time, and one with a high retention time.

If you do not select an internal standard, select Use Normalisation to run auto normalization—quantitation without reference to an exact internal standard. Clear Use Normalisation if you do not want any normalization to be used.

Tip: Use auto normalization only if you suspect that the majority of proteins in the samples of interest are at similar concentration levels. Auto normalization assumes that the majority of proteins in the samples of interest are not changing in regulation when compared with more gross protein samples of interest.

Viewing results

When the expression analysis is configured and run, results tables are generated. Depending on the experiment setup, there could be an EMRT results table, a Protein results table, or both.

The ProteinLynx Global SERVER User’s Guide explains in detail how to manage your results, and use the various tools available to curate the results.

Exporting results

You can print your expression analysis results (using one of the built-in templates, or one of your own) or export them to a file. Because the results tables can be very large, you might wish to filter the results first.

For details of how to print and export your results, refer to the ProteinLynx Global SERVER User’s Guide.
A Safety Advisories

Waters instruments display hazard symbols designed to alert you to the hidden dangers of operating and maintaining the instruments. Their corresponding user guides also include the hazard symbols, with accompanying text statements describing the hazards and telling you how to avoid them. This appendix presents all the safety symbols and statements that apply to the entire line of Waters products.

Contents:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning symbols</td>
<td>A-2</td>
</tr>
<tr>
<td>Caution symbol</td>
<td>A-5</td>
</tr>
<tr>
<td>Warnings that apply to all Waters instruments</td>
<td>A-5</td>
</tr>
<tr>
<td>Electrical and handling symbols</td>
<td>A-12</td>
</tr>
</tbody>
</table>
Warning symbols

Warning symbols alert you to the risk of death, injury, or seriously adverse physiological reactions associated with an instrument’s use or misuse. Heed all warnings when you install, repair, and operate Waters instruments. Waters assumes no liability for the failure of those who install, repair, or operate its instruments to comply with any safety precaution.

Task-specific hazard warnings

The following warning symbols alert you to risks that can arise when you operate or maintain an instrument or instrument component. Such risks include burn injuries, electric shocks, ultraviolet radiation exposures, and others.

When the following symbols appear in a manual’s narratives or procedures, their accompanying text identifies the specific risk and explains how to avoid it.

⚠️ **Warning:** (General risk of danger. When this symbol appears on an instrument, consult the instrument’s user documentation for important safety-related information before you use the instrument.)

⚠️ **Warning:** (Risk of burn injury from contacting hot surfaces.)

⚠️ **Warning:** (Risk of electric shock.)

⚠️ **Warning:** (Risk of fire)

⚠️ **Warning:** (Risk of needle puncture.)

⚠️ **Warning:** (Risk of injury caused by moving machinery.)

⚠️ **Warning:** (Risk of exposure to ultraviolet radiation.)

⚠️ **Warning:** (Risk of contacting corrosive substances.)

⚠️ **Warning:** (Risk of exposure to a toxic substance.)
Warnings that apply to particular instruments, instrument components, and sample types

The following warnings can appear in the user manuals of particular instruments and on labels affixed to them or their component parts.

Burst warning

This warning applies to Waters instruments fitted with nonmetallic tubing.

**Warning:** Pressurized nonmetallic, or polymer, tubing can burst. Observe these precautions when working around such tubing:

- Wear eye protection.
- Extinguish all nearby flames.
- Do not use tubing that is, or has been, stressed or kinked.
- Do not expose nonmetallic tubing to incompatible compounds like tetrahydrofuran (THF) and nitric or sulfuric acids.
- Be aware that some compounds, like methylene chloride and dimethyl sulfoxide, can cause nonmetallic tubing to swell, which significantly reduces the pressure at which the tubing can rupture.

Mass spectrometer flammable solvents warning

This warning applies to instruments operated with flammable solvents.

**Warning:** Where significant quantities of flammable solvents are involved, a continuous flow of nitrogen into the ion source is required to prevent possible ignition in that enclosed space.

Ensure that the nitrogen supply pressure never falls below 400 kPa (4 bar, 58 psi) during an analysis in which flammable solvents are used. Also ensure a gas-fail connection is connected to the HPLC system so that the LC solvent flow stops if the nitrogen supply fails.
Mass spectrometer shock hazard

This warning applies to all Waters mass spectrometers.

**Warning:** To avoid electric shock, do not remove the mass spectrometer’s protective panels. The components they cover are not user-serviceable.

This warning applies to certain instruments when they are in Operate mode.

**Warning:** High voltages can be present at certain external surfaces of the mass spectrometer when the instrument is in Operate mode. To avoid non lethal electric shock, make sure the instrument is in Standby mode before touching areas marked with this high voltage warning symbol.

Biohazard warning

This warning applies to Waters instruments that can be used to process material that might contain biohazards: substances that contain biological agents capable of producing harmful effects in humans.

**Warning:** Waters’s instruments and software can be used to analyze or process potentially infectious human-sourced products, inactivated microorganisms, and other biological materials. To avoid infection with these agents, assume that all biological fluids are infectious, observe good laboratory practices and, consult your organization’s biohazard safety representative regarding their proper use and handling. Specific precautions appear in the latest edition of the US National Institutes of Health (NIH) publication, *Biosafety in Microbiological and Biomedical Laboratories* (BMBL).
Chemical hazard warning

This warning applies to Waters instruments that can process corrosive, toxic, flammable, or other types of hazardous material.

⚠️ Warning: Waters instruments can be used to analyze or process potentially hazardous substances. To avoid injury with any of these materials, familiarize yourself with the materials and their hazards, observe Good Laboratory Practices (GLP), and consult your organization’s safety representative regarding proper use and handling. Guidelines are provided in the latest edition of the National Research Council's publication, *Prudent Practices in the Laboratory: Handling and Disposal of Chemicals*.

Caution symbol

The caution symbol signifies that an instrument’s use or misuse can damage the instrument or compromise a sample’s integrity. The following symbol and its associated statement are typical of the kind that alert you to the risk of damaging the instrument or sample.

⚠️ Caution: To avoid damage, do not use abrasives or solvents to clean the instrument’s case.

Warnings that apply to all Waters instruments

When operating this device, follow standard quality control procedures and the equipment guidelines in this section.
Attention: Changes or modifications to this unit not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

Important: Toute modification sur cette unité n’ayant pas été expressément approuvée par l’autorité responsable de la conformité à la réglementation peut annuler le droit de l’utilisateur à exploiter l’équipement.

Achtung: Jedwede Änderungen oder Modifikationen an dem Gerät ohne die ausdrückliche Genehmigung der für die ordnungsgemäße Funktionstüchtigkeit verantwortlichen Personen kann zum Entzug der Bedienungsbefugnis des Systems führen.

Avvertenza: eventuali modifiche o alterazioni apportate a questa unità e non espressamente approvate da un ente responsabile per la conformità annulleranno l’autorità dell’utente ad operare l’apparecchiatura.

Atencion: cualquier cambio o modificación efectuado en esta unidad que no haya sido expresamente aprobado por la parte responsable del cumplimiento puede anular la autorización del usuario para utilizar el equipo.

注意：未经有关法規認證部門允許對本設備進行的改變或修改，可能會使使用者喪失操作該設備的權利。

注意：未经有关法规认证部门明确允许对本设备进行的改变或改装，可能会使使用者丧失操作该设备的合法性。

주의：기기 검교정 담당자의 승인 없이 무단으로 기기를 변경 또는 수정하는 경우에 는, 그 기기 운영에 대한 허가가 취소될 수 있습니다.

注意：規制機関から明確な承認を受けずに本装置の変更や改造を行うと、本装置のユーザとしての承認が無効になる可能性があります。
**Warning:** Use caution when working with any polymer tubing under pressure:

- Always wear eye protection when near pressurized polymer tubing.
- Extinguish all nearby flames.
- Do not use tubing that has been severely stressed or kinked.
- Do not use nonmetallic tubing with tetrahydrofuran (THF) or concentrated nitric or sulfuric acids.
- Be aware that methylene chloride and dimethyl sulfoxide cause nonmetallic tubing to swell, which greatly reduces the rupture pressure of the tubing.

**Attention:** Manipulez les tubes en polymère sous pression avec précaution:

- Portez systématiquement des lunettes de protection lorsque vous vous trouvez à proximité de tubes en polymère pressurisés.
- Eteignez toute flamme se trouvant à proximité de l'instrument.
- Evitez d'utiliser des tubes sévèrement déformés ou endommagés.
- Evitez d'utiliser des tubes non métalliques avec du tétrahydrofurane (THF) ou de l'acide sulfurique ou nitrique concentré.
- Sachez que le chlorure de méthylène et le diméthylesulfoxyde entraînent le gonflement des tuyaux non métalliques, ce qui réduit considérablement leur pression de rupture.

**Vorsicht:** Bei der Arbeit mit Polymerschläuchen unter Druck ist besondere Vorsicht angebracht:

- In der Nähe von unter Druck stehenden Polymerschläuchen stets Schutzbrille tragen.
- Alle offenen Flammen in der Nähe löschen.
- Keine Schläuche verwenden, die stark geknickt oder überbeansprucht sind.
- Nichtmetallische Schläuche nicht für Tetrahydrofuran (THF) oder konzentrierte Salpeter- oder Schwefelsäure verwenden.
- Durch Methylenechlorid und Dimethylsulfoxid können nichtmetallische Schläuche quellen; dadurch wird der Berstdruck des Schlauches erheblich reduziert.
Attenzione: prestare attenzione durante l’utilizzo dei tubi di polimero pressurizzati:

- Indossare sempre occhiali da lavoro protettivi nei pressi di tubi di polimero pressurizzati.
- Estinguere ogni fonte di ignizione circostante.
- Non utilizzare tubi soggetti che hanno subito sollecitazioni eccessive o sono stati incurvati.
- Non utilizzare tubi non metallici con tetraidrofurano (THF) o acido solforico o nitrico concentrato.
- Tenere presente che il cloruro di metilene e il dimetilsolfossido provocano rigonfiamento nei tubi non metallici, riducendo notevolmente la resistenza alla rottura dei tubi stessi.

Advertencia: se recomienda precaución cuando se trabaje con tubos de polímero sometidos a presión:

- El usuario deberá protegerse siempre los ojos cuando trabaje cerca de tubos de polímero sometidos a presión.
- Si hubiera alguna llama las proximidades.
- No se debe trabajar con tubos que se hayan doblado o sometido a altas presiones.
- Es necesario utilizar tubos de metal cuando se trabaje con tetrahidrofurano (THF) o ácidos nítrico o sulfúrico concentrados.
- Hay que tener en cuenta que el cloruro de metileno y el sulfóxido de dimetilo dilatan los tubos no metálicos, lo que reduce la presión de ruptura de los tubos.

警告: 當在有壓力的情況下使用聚合物管線時，小心注意以下幾點:

- 當接近有壓力的聚合物管線時一定要戴防護眼鏡。
- 熄滅附近所有的火焰。
- 不要使用已經被壓瘪或嚴重彎曲管線。
- 不要在非金屬管線中使用四氫呋喃或濃硝酸或濃硫酸。
- 要了解使用二氯甲烷及二甲基亞楓會導致非金屬管線膨脹，大大降低管線的耐壓能力。
Warnings that apply to all Waters instruments

**Warnings that apply to all Waters instruments A-9**

**경고:** 폴리머재질의 튜빙을 압력하에서 사용할 때는 다음 사항에 유의하십시오.
- 압력을 받은 폴리머 튜빙 부근에서는 반드시 보호안경을 착용할 것
- 모든 화기의 접근을 금함
- 늘리거나 뒤집힌 튜빙은 사용하지 말 것
- 비금속 튜빙은 테트라하이드로퓨린(THF)이나 염산 및 황산과 함께 사용하지 말 것
- 디메틸사포산(dimethy sulfoxide)는 비금속 튜빙을 폭발시켜 쉽게 파열되므로 주의할 것

**警告:** ポリマーチューブに圧力をかけて取り扱う場合は、次のように注意してください。
- 加圧したポリマーチューブの付近では、常に保護めがねを着用してください。
- 付近の火はすべて消してください。
- 激しい応力やねじれを受けたチューブは使用しないでください。
- テトラヒドロフラン(THF)、濃硝酸、あるいは濃硫酸には、非金属製のチューブを使用しないでください。
- ジクロロメタンやジメチルホキシドは非金属製のチューブを膨張させ、チューブの破断圧力を大幅に低下させますので、注意してください。
Warning: The user shall be made aware that if the equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.

Attention: L'utilisateur doit être informé que si le matériel est utilisé d’une façon non spécifiée par le fabricant, la protection assurée par le matériel risque d’être défectueuse.

Vorsicht: Der Benutzer wird darauf aufmerksam gemacht, dass bei unsachgemäßer Verwendung des Gerätes unter Umständen nicht ordnungsgemäß funktionieren.

Attenzione: l’utente deve essere al corrente del fatto che, se l’apparecchiatura viene usata in un modo specificato dal produttore, la protezione fornita dall’apparecchiatura potrà essere invalidata.

Advertencia: el usuario deberá saber que si el equipo se utiliza de forma distinta a la especificada por el fabricante, las medidas de protección del equipo podrían ser insuficientes.

警告：使用者必須非常清楚如果設備不是按照製造廠商指定的方式使用，那麼該設備所提供的保護將被消弱。

警告：使用者必須非常清楚如果設備不是按照製造廠商指定的方式使用，那麼該設備所提供的保護將被消弱。

경고：제조사가 지정한 것 이외의 방법으로 기기를 사용하는 경우에는, 사용자가 위험으로부터 보호될 수 없는 경우가 발생할 수 있음에 유념하십시오。

警告：ユーザは製造業者が指定していない方法で装置を使用した場合は装置が提供する保護が損なわれることがあるということを承知しているものとします。
Warning: To protect against fire hazard, replace fuses with those of the same type and rating.

Attention: Remplacez toujours les fusibles par d’autres du même type et de la même puissance afin d’éviter tout risque d’incendie.

Vorsicht: Zum Schutz gegen Feuergefahr die Sicherungen nur mit Sicherungen des gleichen Typs und Nennwertes ersetzen.

Attenzione: per una buona protezione contro i rischi di incendio, sostituire i fusibili con altri dello stesso tipo e amperaggio.

Advertencia: sustituya los fusibles por otros del mismo tipo y caracteristicas para evitar el riesgo de incendio.

警告：為了避兔火災的危險，應更換同種類型及規格的保險絲。

警告：为了避免火灾的危险，应更换同种类型及规格的保险丝。

경고： 화재를 방지하기 위해서는 퓨즈 교체 시 같은 종류, 같은 등급의 것을 사용하십시오.

警告：火災の危険防止のために、ヒューズの交換は同一タイプおよび定格のもので行なってください。
Warning: To avoid possible electrical shock, disconnect the power cord before servicing the instrument.

Attention: Afin d’éviter toute possibilité de commotion électrique, débranchez le cordon d’alimentation de la prise avant d’effectuer la maintenance de l’instrument.

Vorsicht: Zur Vermeidung von Stromschlägen sollte das Gerät vor der Wartung vom Netz getrennt werden.

Attenzione: per evitare il rischio di scossa elettrica, scollegare il cavo di alimentazione prima di svolgere la manutenzione dello strumento.

Precaución: para evitar descargas eléctricas, desenchufe el cable de alimentación del instrumento antes de realizar cualquier reparación.

警告：要避免觸電，請在修理或保養器材前把電源線拔出。

警告：为避免可能引起得触电危险，在修理前请切断电源连接。

경고: 전기 충격의 가능성을 피하기 위해서는, 기기를 수리하기 이전에 전원 코드를 차단하십시오。

警告：感電の危険性を避けるために、装置の保守を行う前には装置の電源コードを引き抜いてください。

Electrical and handling symbols

Electrical symbols

These can appear in instrument user manuals and on the instrument’s front or rear panels.

<table>
<thead>
<tr>
<th></th>
<th>Electrical power on</th>
</tr>
</thead>
</table>
### Handling symbols

These handling symbols and their associated text can appear on labels affixed to the outer packaging of Waters instrument and component shipments.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="symbol1.png" alt="Electrical power off" /></td>
<td>Electrical power off</td>
</tr>
<tr>
<td><img src="symbol2.png" alt="Standby" /></td>
<td>Standby</td>
</tr>
<tr>
<td><img src="symbol3.png" alt="Direct current" /></td>
<td>Direct current</td>
</tr>
<tr>
<td><img src="symbol4.png" alt="Alternating current" /></td>
<td>Alternating current</td>
</tr>
<tr>
<td><img src="symbol5.png" alt="Protective conductor terminal" /></td>
<td>Protective conductor terminal</td>
</tr>
<tr>
<td><img src="symbol6.png" alt="Frame, or chassis, terminal" /></td>
<td>Frame, or chassis, terminal</td>
</tr>
<tr>
<td><img src="symbol7.png" alt="Fuse" /></td>
<td>Fuse</td>
</tr>
<tr>
<td><img src="symbol8.png" alt="Recycle symbol" /></td>
<td>Recycle symbol: Do not dispose in municipal waste.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="symbol9.png" alt="Keep upright" /></td>
<td>Keep upright!</td>
</tr>
<tr>
<td><img src="symbol10.png" alt="Keep dry" /></td>
<td>Keep dry!</td>
</tr>
<tr>
<td>Fragile!</td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>Use no hooks!</td>
<td></td>
</tr>
</tbody>
</table>
Sample preparation

Contents:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparation of standard compounds</td>
<td>B-2</td>
</tr>
<tr>
<td>Performance verification standard solutions (75-µm column)</td>
<td>B-3</td>
</tr>
<tr>
<td>Performance verification standard solutions (300-µm column)</td>
<td>B-6</td>
</tr>
<tr>
<td>Digestion procedures (solution phase and in-gel)</td>
<td>B-8</td>
</tr>
</tbody>
</table>
Preparation of standard compounds

Instrument tuning standards

You must prepare two standards to tune the instrument:

- For general tuning, infuse \([\text{Glu}^1]-\text{Fibrinopeptide B}\) (Sigma F3261), 100 fmol/µL, in 25% acetonitrile/0.1% formic acid (v/v) at 300 nL/min.
- For tuning to minimize low energy fragmentation, use angiotensin II, 100 fmol/µL, in 25% acetonitrile/0.1% formic acid (v/v) at 300 nL/min.

Lock mass reference standards

Infuse at 300 nL/min a 1:1 mix of these compounds:

- 200 fmol/µL \([\text{glu}^1]-\text{Fibrinopeptide B}\) (Sigma F3261) in 25% acetonitrile/0.1% formic acid (v/v). For glu-fibrinopeptide, m/z = 785.8426, +2.
- 50 fmol/µL erythromycin (Sigma, E6376-25G). For the erythromycin, m/z = 716.4585, and 1 dehydrated form (734.4690 m/z +1, C_{37}H_{67}NO_{13}).

**Recommendation:** To ensure it remains stable, refrigerate erythromycin when storing it. Use the refrigerated erythromycin to replenish the lock mass solution.

Calibration standards

**Note:** As an alternative to the standards listed in this section, you can use a another calibration solution so long as its reference points extend across the required mass range.

**Sodium cesium Iodide**

According to the calibration reference file “Naics2.ref.” in MassLynx software, the NaICs solution gives 14 calibration points over the m/z range 50 to 1990.

**To prepare sodium cesium iodide:**

1. Make up sodium and cesium iodide to 2 mg/mL in a 50% v/v solution of isopropanol to a ratio of 1:19 cesium/sodium.
2. Infuse the solution into the instrument at 0.5µL/min, using the adjuster assembly to withdrawing the sprayer to give the required number of counts.

**See also:** For information on using the adjuster assembly, refer to the *Q-Tof Premier Mass Spectrometer Operator’s Guide*.

[Glut^1]-fibrinopeptide B

You can infuse glu-fibrinopeptide into the instrument at a concentration of 100 fmol/µL at 0.5µL/min, and use the MS-MS spectrum that the solution generates for calibration.

**Sodium formate**

Warning: Use extreme care when working with formic acid. Perform all operations inside a fume hood, and wear appropriately protective goggles, gloves, and clothing.

You need these stock solutions to make up a calibration solution of sodium formate:

- 0.1 M sodium hydroxide
- 10% (v/v) formic acid

**Recommendation:** Prepare the solution immediately before each instrument calibration.

**To prepare sodium formate solution:**

1. To 800 µL of a 50% acetonitrile/water (v/v) solution, add 100 µL of 0.1 M sodium hydroxide stock.
2. Add 100 µL of the 10% formic acid.
Performance verification standard solutions (75-µm column)

The injection volume used for all performance verification standards is 2 µL.

LC/MS performance verification test standard

Enolase

To prepare enolase:

1. Add 1 mL of aqueous 0.1% formic acid per enolase tube (part number 186002325; 1 tube = 1 nmol) to give 1 pmol/µL of enolase stock solution.

2. Immediately before use, add 10 µL of the enolase stock to 390 µL aqueous 0.1% formic acid to give 25 fmol/µL.

Protein Expression system performance verification standards

Use MassPREP digestion standard (MPDS) Mixture 1 (part number 1860002865) and MPDS Mixture 2 (part number 1860002866) as the system’s performance verification test standards. Both standards contain alcohol dehydrogenase, glycogen phosphorylase B, bovine serum albumin, and enolase. The following table indicates the ratios of the compounds in the two mixtures.

Mixture 1 and mixture 2 ratios:

<table>
<thead>
<tr>
<th>Compound</th>
<th>Ratio of Mixture 1:Mixture 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alcohol dehydrogenase</td>
<td>1</td>
</tr>
<tr>
<td>Glycogen phosphorylase B</td>
<td>2</td>
</tr>
<tr>
<td>Bovine serum albumin</td>
<td>0.125</td>
</tr>
<tr>
<td>Enolase</td>
<td>0.5</td>
</tr>
</tbody>
</table>

Sample Preparation

To prepare the standards:
1. Dissolve Mix 1 and Mix 2 with 1 mL of water with 0.1% formic acid.
   **Result:** Creates a stock solution with an equal concentration of alcohol dehydrogenase for both mixes.

2. Mix 50 µL of the Mix 1 stock solution with 50 µL aqueous 0.1% formic acid in a Waters Maximum Recovery Vial (part number 186000327).

3. Mix 50 µL of the Mix 2 stock solution with 50 µL aqueous 0.1% formic acid in another maximum recovery vial.

4. Label the vials as follows:
   • Mix 1, 75 µm
   • Mix 2, 75 µm

**E. coli system training mix**

**Requirement:** One *E. coli* vial (part number 186003196). An *E. coli* vial is provided during applications training.

**To prepare standards with *E. coli***:

1. Dissolve Mix 1 and Mix 2 in 1 mL of water containing 0.1% formic acid.
   **Result:** A stock solution with an equal concentration of alcohol dehydrogenase for both mixes is created.

2. Dissolve a vial of *E. coli* with 250 µL of water with 0.1% formic acid.

3. Mix 50 µL of the Mix 1 stock solution with 50 µL of the *E. coli* solution in a maximum recovery vial.

4. Mix 50 µL of the Mix 2 stock solution with 50 µL of the *E. coli* solution in a second maximum recovery vial.

5. Label the vials as follows:
   • Mix1, *E. coli*, 75 µm
   • Mix2, *E. coli*, 75 µm

**Note:** *E. coli* is spiked into the MPDS only as a training exercise. You need not analyze the spiked sample continually as a performance check, nor does Waters recommend you do so.
Performance verification standard solutions (300-µm column)

The injection volume for these standards is 2 µL.

LC/MS Performance verification tests standard

Enolase

To prepare enolase:

1. Add 1 mL of aqueous 0.1% formic acid per enolase tube (1 tube = 1 nmol) (part number 186002325) to give 1 pmol/µL of enolase stock solution.

2. Immediately before use, add 100 µL of the enolase stock to 300 µL aqueous 0.1% formic acid to give 250 fmol/µL.

Protein Expression system performance verification standards

Use MassPREP digestion standard (MPDS) Mixture 1 (part number 1860002865) and MPDS Mixture 2 (part number 1860002866) as the system’s performance verification test standards. Both standards contain alcohol dehydrogenase, glycogen phosphorylase B, bovine serum albumin, and enolase. The following table indicates the ratios of the compounds in the two mixtures.

Mixture 1 and mixture 2 ratios:

<table>
<thead>
<tr>
<th>Compound</th>
<th>Ratio of Mixture 1 to Mixture 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alcohol dehydrogenase</td>
<td>1</td>
</tr>
<tr>
<td>Glycogen phosphorylase B</td>
<td>2</td>
</tr>
<tr>
<td>Bovine serum albumin</td>
<td>0.125</td>
</tr>
<tr>
<td>Enolase</td>
<td>0.5</td>
</tr>
</tbody>
</table>

Sample preparation

To prepare the standards:
1. Dissolve Mix 1 and Mix 2 with 100 µL of water with 0.1% formic acid.
   **Result:** Creates a stock solution with an equal concentration of alcohol dehydrogenase for both mixes.

2. Mix 40 µL of the Mix 1 stock solution with 40 µL aqueous 0.1% formic acid in a maximum recovery vial.

3. Mix 40 µL of the Mix 2 stock solution with 40 µL aqueous 0.1% formic acid in another maximum recovery vial.

4. Label the vials as follows:
   • Mix1, 300 µm
   • Mix2, 300 µm

**E. coli system training mix**

**Requirement:** Two *E. coli* vials (100 µg/vial, part number 186003196). *E. coli* vials are provided during applications training.

**To prepare *E. coli* standards:**

1. Dissolve Mix 1 and Mix 2 in 100 µL of aqueous 0.1% formic acid.
   **Result:** Creates a stock solution with an equal concentration of alcohol dehydrogenase for both mixes.

2. Dissolve one vial of *E. coli* in 50 µL of aqueous 0.1% formic acid.

3. Transfer the 50 µL from this vial to the second *E. coli* vial.

4. Mix 20 µL of the Mix 1 stock solution with 20 µL of the *E. coli* solution in a Waters Maximum Recovery Vial (part number 186000327).

5. Mix 20 µL of the Mix 2 stock solution with 20 µL of the *E. coli* solution in a second maximum recovery vial.

6. Label the vials as follows:
   • Mix1, *E. coli*, 300 µm
   • Mix2, *E. coli*, 300 µm

**Note:** *E. coli* is spiked into the MPDS only as a training exercise. You need not analyze the spiked sample continually as a performance check, nor does Waters recommend you do so.
Digestion procedures (solution phase and in-gel)

Considerations for sample digestion

Useful quantitative and qualitative results from the Protein Expression system depend on robust and reproducible sample preparation methods. Two protocols (one for cytosolic proteins and another for serum samples) reliably produce digests on a day-to-day basis. You must generate all samples used for protein expression analysis using these protocols and their indicated reagents.

Biological samples can contain additional additives that might interfere with the digestion, reversed phase chromatography, or ESI-MS detection. These are some common additives:

- Protease inhibitors
- Denaturants (urea, guanidine, for example)
- Detergents
- Non-volatile salts and buffers (and high ionic strength)
- Ethylene diamine tetra-acetic acid (EDTA)
- Organic solvents
- Reducing agents
- Glycerol
- Sugars

The absolute and concentration-dependent effects of these substances have not been characterized with the Protein Expression system, and they should be avoided in sample preparation workflows. If they are present as components of a sample, you might need to remove them prior to digestion by using ultrafiltration/buffer exchange or protein precipitation techniques.

Reagents required for sample digestion:

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>DTT</td>
<td>Sigma Chemical Co. SigmaUltra Grade DTT (Cat No D-5545)</td>
</tr>
<tr>
<td></td>
<td>FW 154.3 g/mol</td>
</tr>
</tbody>
</table>
Reagents required for sample digestion (Continued):

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>IA (iodoacetamide)</td>
<td>Sigma Chemical Co. SigmaUltra Grade Iodoacetamide (Cat No I-1149)</td>
</tr>
<tr>
<td></td>
<td>FW 185.0 g/mol</td>
</tr>
<tr>
<td>AmBic (ammonium bicarbonate)</td>
<td>(Sigma Chemical Co. SigmaUltra Grade Ammonium Bicarbonate (Cat No A-6141)</td>
</tr>
<tr>
<td></td>
<td>FW 79.1 g/mol</td>
</tr>
<tr>
<td>RapiGest™ SF</td>
<td>Waters Corporation</td>
</tr>
<tr>
<td></td>
<td>• 1 x 1 mg – 186001860</td>
</tr>
<tr>
<td></td>
<td>• 5 x 1 mg – 186001861</td>
</tr>
<tr>
<td></td>
<td>• 1 x 10 mg – 186002123</td>
</tr>
<tr>
<td></td>
<td>• 1 x 50 mg – 186002122</td>
</tr>
<tr>
<td>Trypsin</td>
<td>Promega Sequencing Grade Modified 5 x 20 µg (Cat No V-5111)</td>
</tr>
</tbody>
</table>

Instrumentation required for digestion:

- Pipets for microliter-scale to milliliter-scale liquid delivery
- Heating blocks or baths (adjustable, multiple preferred)
- Microcentrifuge
- 0.5-mL microcentrifuge tubes
- Vortex mixer
- Proper safety equipment (lab coat, gloves, glasses with eye shields or goggles)
**Procedure for a 1 mg digest of an *E. coli* cytosolic fraction**

**Solutions needed for *E. coli* cytosolic fraction:**

<table>
<thead>
<tr>
<th>Solution</th>
<th>Directions</th>
<th>Storage</th>
<th>Number of digests</th>
</tr>
</thead>
<tbody>
<tr>
<td>500 mL of 25 mM AmBic</td>
<td>0.99 g AmBic in 500 mL dd water</td>
<td>4 °C; use within weeks</td>
<td>1000+</td>
</tr>
<tr>
<td>10 mL of 100 mM DTT</td>
<td>0.154 g DTT in 10 mL 25 mM AmBic</td>
<td>Ice; use within hours</td>
<td>1000+</td>
</tr>
<tr>
<td>10 mL of 300 mM IA</td>
<td>0.555 g IA in 25 mM AmBic</td>
<td>Ice; use within hours</td>
<td>1000+</td>
</tr>
<tr>
<td>100 µL of 1% RapiGest SF</td>
<td>Resuspend 1 mg RapiGest SF in 0.1 mL 25 mM AmBic</td>
<td>4 °C; use within a day</td>
<td>7</td>
</tr>
<tr>
<td>80 µL of 0.25 mg/mL Trypsin</td>
<td>Resuspend 1 × 20 µg vial in 80 µL 25 mM AmBic</td>
<td>RT; prepare 15 minutes before use</td>
<td>1-2</td>
</tr>
</tbody>
</table>

**To perform a cytosolic protein digestion:**

**Required:** A 0.5 mL tube (final volume: 0.25 mL; final protein concentration: 4

1. To a 0.5 mL tube, add 10.4 µL of *E. coli* cytosol (95 mg/mL, 1 mg).
2. Add 175 µL of 25 mM AmBic.
3. Add 12.5 µL of 1% RapiGest SF (0.05% final).
4. Heat at 80 °C for 10 min., and briefly vortex mix after ~5 min.
5. Add 6.2 µL of 100 mM DTT (2.5 mM final), and briefly vortex mix.
6. Heat at 60 °C for 10 min.
7. Cool sample to room temperature, and centrifuge (low speed) to return condensate to bottom of tube.
8. Add 6.2 µL of 300 mM IA (7.5 mM final), and briefly vortex mix.
9. Store in darkness at room temperature for 30 min.
10. Add 40 µL 0.25 mg/mL Trypsin (1:100 w/w, 10 µg), and briefly vortex mix.
11. Incubate for between 12 and 16 hours at 37 °C.

12. Microcentrifuge (30 min, 4 °C, 13,000 rpm), retain supernatant.

13. Follow the RapiGest hydrolyzation process, described on page B-12.

Tip:: For a global digest sample, maximum loading amounts are ~20 µg (300-µm ID columns) and ~1 µg (75-µm ID columns). These limits can vary (+/-) due to column loading capacity and MS sensitivity issues.

Procedure for digestion of serum

Solutions for serum digestion:

<table>
<thead>
<tr>
<th>Solution</th>
<th>Directions</th>
<th>Storage</th>
<th>Number of digests</th>
</tr>
</thead>
<tbody>
<tr>
<td>500 mL of 100 mM AmBic</td>
<td>3.96 g AmBic/500 mL ddWater</td>
<td>4 °C; use within weeks</td>
<td>1000+</td>
</tr>
<tr>
<td>10 mL of 100 mM DTT</td>
<td>0.154 g DTT in 10 mL Water</td>
<td>Ice; use within hours</td>
<td>1000+</td>
</tr>
<tr>
<td>10 mL of 300 mM IA</td>
<td>0.555 g IA in 10 mL Water</td>
<td>Ice; use within hours</td>
<td>1000+</td>
</tr>
<tr>
<td>500 µL of 0.2% RapiGest SF</td>
<td>Resuspend 1 mg RapiGest SF in 0.5 mL water</td>
<td>4 °C; use within a day</td>
<td>20</td>
</tr>
<tr>
<td>400 µL of 50 µg/mL Trypsin</td>
<td>Resuspend 1 × 20 µg vial in 400 µL</td>
<td>RT; prepare 15 minutes before use</td>
<td>8</td>
</tr>
</tbody>
</table>

To perform a tryptic digestion of sera:

1. Dispense 5 µL of serum (250 to 300 µg of protein) in a capped micro-centrifuge tube of greater than 200-µL volume.

2. Add 20 µL of 100 mM ammonium bicarbonate.

3. Add 25 µL of 0.2% solution of RapiGest SF in water, and vortex mix.

   To make the solution: Add 500 µL of water to a 1 mg vial of RapiGest SF.

4. Place the tube in a block heater set at 80 °C. Heat for 15 minutes, vortex mixing periodically.
5. Remove from block and centrifuge to return condensate to the bottom of
   the tube.
6. Add 2.5 µL of 100 mM dithiothreitol (15.4 mg/mL in water), and vortex
   mix.
7. Place the tube in a block heater set at 60 °C for 30 minutes.
8. Remove the tube from the block, allow it to cool to room temperature,
   and then centrifuge, forcing the condensate to the bottom of the tube.
9. Add 2.5 µL of 200 mM iodoacetamide (55.5 mg/mL in water), and vortex
   mix.
10. Put the sample in the dark for 30 minutes at room temperature.
11. Add 50 µL of a solution of promega trypsin in 50 mM ammonium
   bicarbonate, and vortex mix.

   **To make the solution:** Add 400 µL of 50 mM ammonium bicarbonate to
   one 20 µg vial of trypsin. The trypsin/protein ratio will be approximately
   1:100.

12. Place the tube in a block heater set at 37 °C, and incubate overnight.
13. Centrifuge to force condensate to the bottom of the tube.
14. Follow the RapiGest hydrolyzation process, described on page B-12.

**RapiGest hydrolyzation process**

**Recommendation:** Hydrolyze RapiGest at the end of all digestion procedures,
regardless of the sample used.

**To hydrolyze RapiGest:**

1. Add trifluoroacetic acid to the digested protein samples until the
   trifluoroacetic acid concentration reaches 0.5%.

   **Requirement:** You must use high purity trifluoroacetic acid. Waters
   recommends using sealed vials containing 1 mL of high purity
   trifluoroacetic acid.

2. Incubate the sample for between 30 and 45 minutes at 37 °C.

   **Result:** The sample should become slightly cloudy.
3. Centrifuge the acid-treated samples at 13,000 rpm for 10 minutes.

   **Tip:** As the hydrolytic RapiGest SF by-products are water immiscible, you might observe some precipitation.

4. Carefully transfer the solution to another microcentrifuge tube or HPLC sample vial.

**Result:** The sample is ready for LC/MS analysis.

**Diluting the digest**

If you are analyzing the digest directly, you should dilute it 1:1 with water. Doing so reduces RapiGest SF concentration to 0.025% for loading on the reversed phase column. As a result of dilution, all digest concentrations are reduced by half.
This tutorial guides you through the process of performing the following tasks, using the example data supplied on the Expression DVDs:

- Creating a PLGS project
- Creating containers
- Attaching and processing example raw data
- Creating and running Expression experiments

Familiarize yourself with ProteinLynx Global SERVER before following this tutorial. Refer to *ProteinLynx Global SERVER User’s Guide* for additional detail and clarification.

Ensure that PLGS is running on the computer you are using, and also on the server if one is being used. For information on how to start PLGS, refer to *ProteinLynx Global SERVER User’s Guide*.

**Contents:**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a PLGS project</td>
<td>C-2</td>
</tr>
<tr>
<td>Creating samples in Sample Manager</td>
<td>C-2</td>
</tr>
<tr>
<td>Creating a processing parameters template</td>
<td>C-3</td>
</tr>
<tr>
<td>Creating containers</td>
<td>C-3</td>
</tr>
<tr>
<td>Attaching and processing example raw data</td>
<td>C-3</td>
</tr>
<tr>
<td>Creating and running Protein Expression experiments</td>
<td>C-6</td>
</tr>
</tbody>
</table>

If at any time you want to save your example project and results, in ProteinLynx Browser click File > Save.
Creating a PLGS project

To create a project:
1. Start ProteinLynx Browser.
2. Click File > New Project.
3. Type MyExample as the name for the project.
4. Click OK.
If at any time you want to save your example project and results, in ProteinLynx Browser click File > Save.

Creating samples in Sample Manager

To create samples:
1. In ProteinLynx Browser, click Tools > Sample Manager.
2. In the tree, click Original Samples, and then right-click.
3. Click Add New Sample.
4. Click No when you are asked whether you want to add the sample to a vial.
5. In the lower panel, titled Edit Sample, click the Name attribute.
6. Scroll to the bottom of the panel and, in the Name box, type MyExampleSample1.
7. Click Update.
   **Result:** Both the name displayed in the Edit Sample panel and the name displayed in the tree are updated.
8. Repeat steps 2 to 7, specifying MyExampleSample2 as the name for the next sample.
Creating a processing parameters template

To create a processing parameters template:

1. In ProteinLynx Browser, click Tools > Data Preparation.
2. Click File > New.
3. Select Electrospray-MS\textsuperscript{E}, and then click ✓.
4. In the Title box, type MyExampleParams.
5. Click File > Save.
6. Type MyExampleParams for the file name, and then click Save.

Tip: In your production Protein Expression System, you should consider the settings in the processing parameters template carefully to ensure that data processing reflects your requirements.

Creating containers

To create containers:

1. In ProteinLynx Browser, click Tools > Container Manager.
2. In the tree, click Vials, and then right-click.
3. Click New Vial.
4. Type MyExampleVial1 as the name, and then click OK.

Result: A new node is added to the tree, under Vials.
5. Expand the Vials node to display MyExampleVial1.
6. Repeat steps 2 to 5, specifying MyExampleVial2 as the name for the next vial.

Attaching and processing example raw data

To extract the sample data:

1. Create an empty folder on your PC’s hard drive.
2. From your Protein Expression System DVD, unzip the file SysVer_Mix1_001.raw.zip into the folder you created.

   **Tip:** This may take a few minutes, as the example raw data are quite large.

3. Repeat steps 1 and 2 for the file SysVer_Mix2_001.raw.zip.

**To attach example raw data:**

1. Returning to ProteinLynx Browser’s Container Manager, expand the Vials node to display MyExampleVial1.

2. Click MyExampleVial1, and then right-click.

3. Click Set Sample.

4. In the Select A Sample dialog box, click MyExampleSample1, and then click OK.

   **Tip:** In a production Protein Expression system you set up and configure samples to meet your own requirements, using Sample Manager. Those samples are then available for you to choose in this dialog box.

5. Click MyExampleVial1, and then right-click.

6. Click Set Raw Data File.

7. Browse to the folder you created, and click SysVer_Mix1_001.raw.

8. Click OK.

9. Repeat steps 1 to 8 for MyExampleVial2, setting the sample as MyExampleSample2 and the raw data file as SysVer_Mix2_001.raw.

**To set the processing parameters template:**

1. In Container Manager, expand the MyExampleVial1 node to display SysVer_Mix1_001.

2. Expand SysVer_Mix1_001 to display “Default (MALDI MS)”.

3. Click the processing parameters icon, 

4. Click Change Processing Parameters.

5. Click the down arrow, and then click “Choose new Processing Parameters Template from file”.

C-4   Quick Start tutorial
Processing Parameters Templates dialog box:

6. Click OK.
7. Click MyExampleParams.xml, and then click Open.

**Result:** MyExampleParams appears beside the processing parameters icon.
8. Repeat steps 1 to 4 for MyExampleVial2.
9. In the Processing Parameters Templates dialog box, click MyExampleParams in the list, and then click OK.

**To process example raw data:**

1. In Container Manager, expand the MyExampleVial1 node to display SysVer_Mix1_001.
2. Click SysVer_Mix1_001, and then right-click.
3. Click Process.
4. Expand the MyExampleVial2 node to display SysVer_Mix2_001.
5. Click SysVer_Mix2_001, then right-click.
6. Click Process.

**Results:**

- PLGS begins to process the data. Depending on the specification of your computer(s) processing could take some time, typically 30 to 40 minutes. Refer to the bottom right-hand corner of the screen for processing progress.
- When processing is complete, additional nodes named SysVer_Mix1_001 and SysVer_Mix2_001 are added. The icons indicate that the nodes represent processed and lock mass–corrected data.
Creating and running Protein Expression experiments

To create and run an experiment:

1. In ProteinLynx Browser, click Tools > Expression Analysis.
2. In the tree, click Expression Analyses, and then right-click.
3. Click New Expression Analysis.
   
   **Result:** The Expression Analysis Design Manager appears in the right-hand side of the screen.

4. Type MyExampleAnalysis for the experiment name, and then click Apply.
5. Ensure that “Place samples into separate groups” is selected, and that MyExampleSample1 and MyExampleSample2 are highlighted.
6. Click Apply.
7. In the Select Data panel, click Apply.
   
   **Results:**
   - The EMRTs (Exact Mass Retention Times) and Proteins are collated.
   - A new results node appears below MyExpressionAnalysis.

8. In the Quantitation Analysis panel, select Generate EMRT Table, and then click Apply.
9. Click GO.
   
   **Results:**
   - Expression analysis begins. Processing can take a few moments. Refer to the bottom right-hand corner of the screen for processing progress.
   - When processing is complete, an additional node named EMRT Table is added to the tree.

Performing a data bank search

**Alternative:** You can create a workflow template and attach it to a data file node in Container Manager. You can then run a data bank search in
Container Manager before you set up your Expression experiment. See the *ProteinLynx Global SERVER User’s Guide* for more information.

**To perform a data bank search on the results of your expression analysis:**

1. Click EMRT Table, and then right-click.
2. Click View Expression Table.
   
   **Result:** The EMRT table appears, showing all the clusters analyzed.

3. Click Set Databank Search Parameters.
4. In the Databank Search parameters window, click Databanks.
5. Scroll to the bottom of the window and click SWISSPROT-1.0. Click X in the top right-hand corner to close the window.

6. In the EMRT table, click Include All Clusters.
7. Click Submit Databank Search.
8. In the Workflow Title dialog box, click OK.
   
   **Result:** The data bank search begins. Searching can take a few moments. Refer to the bottom right-hand corner of the screen for search progress.

9. Click the EMRT table to bring it to the front.
   
   **Result:** Search results (scores and descriptions) appear for some of the EMRTs.

10. Click the Score column heading to order the clusters by score.
Setting method parameter values

A selection of Atlantis and BEH columns are verified for use with Waters Protein Expression System. This appendix provides suggested settings for experiments with verified and non verified BEH columns.

**Important:** The information in this appendix does not imply that the columns listed are verified for use with the Waters Protein Expression System. For information on verified columns and methods, see Chapter 3, “System verification”.

**Contents:**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing MS scan time</td>
<td>D-2</td>
</tr>
<tr>
<td>Changing LC gradient length</td>
<td>D-2</td>
</tr>
<tr>
<td>Suggested method parameter values</td>
<td>D-2</td>
</tr>
</tbody>
</table>
Changing MS scan time

When using short LC gradients (30 minutes, for example), shorter MS scan times tend to increase the number of proteins identified. For example, in experimental observation using a 75-µm BEH column and analyzing *E.Coli*, using an MS scan time of 0.6 seconds significantly increases the number of proteins identified compared with using a scan time of 1.5 seconds.

Longer LC gradients tend to improve peptide separation while decreasing ion intensities. For longer LC gradients, therefore, increasing the MS scan time is likely to be appropriate, although a cautious approach achieves the best results.

Changing LC gradient length

At a given MS scan time, extending the LC gradient length increases the number of protein identifications. While longer LC gradients generally produce better separation, they also broaden peptides’ chromatographic peaks, causing the ion intensities of peptides to decrease compared to intensities from shorter LC gradients.

Lower ion intensities result in low abundance proteins not generating sufficient ion counts for identification, so extending gradient length might not always yield the best results, especially for complex samples. You should monitor the ion intensities observed for complex samples as you optimize your method parameters.

Suggested method parameter values

Some parameter values, in both UPLC® and MS experiment methods, exert a particularly strong influence on the results obtained. The suggested values listed below provide a starting point for successful experiments with BEH columns.

**Note:** The suggested values result from experimental evaluation of certain systems under set conditions. Results can vary, and experimentation is likely to be required.
The information in the following table refers to three columns:

- nanoACQUITY 75 µm × 100 mm BEH 1.7 µm
- nanoACQUITY 100 µm × 100 mm BEH 1.7 µm
- nanoACQUITY 150 µm × 100 mm BEH 1.7 µm

**Suggested values:**

<table>
<thead>
<tr>
<th>Column</th>
<th>75 µm</th>
<th>100 µm</th>
<th>150 µm</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LC flow rate (per minute)</strong></td>
<td>300 nL</td>
<td>500 nL</td>
<td>1.0 µL</td>
</tr>
<tr>
<td><strong>MS scan time (seconds)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30 minute gradient</td>
<td>0.6</td>
<td>0.6</td>
<td>0.4</td>
</tr>
<tr>
<td>60 minute gradient</td>
<td>0.8</td>
<td>0.8</td>
<td>0.6</td>
</tr>
<tr>
<td>90 minute gradient</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
</tr>
</tbody>
</table>

**Condition:** The MS scan times assume a change of mobile phase B (0.1% formic acid in acetonitrile) from 3% to 40% over the course of the gradient.
Setting method parameter values
Warning: To avoid possible excessive leakage of solvent into the laboratory atmosphere, address any safety issues raised by the contents of this Appendix.

Contents:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items exposed to solvent</td>
<td>E-2</td>
</tr>
<tr>
<td>Common ingredients used to prepare mobile phases</td>
<td>E-3</td>
</tr>
</tbody>
</table>
The items detailed in the table below can be exposed to solvent; you must evaluate the safety issues involved if the solvents used in your application differ from the solvents normally used with these items. See “Common ingredients used to prepare mobile phases” on page E-3 for details of the most common ingredients used to prepare mobile phases.

### Items exposed to solvent:

<table>
<thead>
<tr>
<th>Item</th>
<th>Material</th>
</tr>
</thead>
<tbody>
<tr>
<td>O-rings</td>
<td>Viton or PTFE-encapsulated Viton</td>
</tr>
<tr>
<td>Gas tubes</td>
<td>PTFE</td>
</tr>
<tr>
<td>Ion block</td>
<td>Stainless steel</td>
</tr>
<tr>
<td>Ion block support</td>
<td>PEEK</td>
</tr>
<tr>
<td>Corona discharge pin mounting contact</td>
<td>PEEK</td>
</tr>
<tr>
<td>Gas exhaust port</td>
<td>Aluminium</td>
</tr>
<tr>
<td>Isolation valve</td>
<td>Gold-plated aluminium/bronze</td>
</tr>
<tr>
<td>Push-in gas fittings</td>
<td>Nickel/brass</td>
</tr>
<tr>
<td>Source enclosure</td>
<td>Alochromed aluminium</td>
</tr>
<tr>
<td>Source enclosure view port</td>
<td>Toughened plate glass</td>
</tr>
<tr>
<td>Probe adjustment flange</td>
<td>Anodized aluminium, glass filled acetal, and stainless steel</td>
</tr>
<tr>
<td>Probe shaft</td>
<td>PEEK</td>
</tr>
<tr>
<td>Probe adjuster bellows</td>
<td>PTFE</td>
</tr>
<tr>
<td>Waste bottle</td>
<td>Polypropylene</td>
</tr>
<tr>
<td>APPI lamp drive assembly:</td>
<td></td>
</tr>
<tr>
<td>Mounting shaft</td>
<td>Stainless steel</td>
</tr>
<tr>
<td>Repeller electrode</td>
<td>Stainless steel</td>
</tr>
<tr>
<td>Insulator</td>
<td>PEEK</td>
</tr>
<tr>
<td>Lamp window</td>
<td>Magnesium fluoride</td>
</tr>
</tbody>
</table>
Common ingredients used to prepare mobile phases

These are the most common ingredients used to prepare mobile phases for reverse-phase LC/MS (API):

• Water
• Methanol
• Acetonitrile
• Formic acid (<0.1%)
• Acetic acid (<1%)
• Trifluoroacetic acid (<0.1%)
• Ammonium acetate (<10 mM)
• Ammonium formate (<10 mM)

These solvents are not expected to cause any problems with the materials identified in “Items exposed to solvent” on page E-2.
<table>
<thead>
<tr>
<th>Glossary Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>AFAMM</td>
<td>all file accurate mass measure.</td>
</tr>
<tr>
<td>API</td>
<td>atmospheric ionization.</td>
</tr>
<tr>
<td>APCI</td>
<td>atmospheric chemical ionization.</td>
</tr>
<tr>
<td>atomic mass</td>
<td>the mass of an atom, or isotope, usually expressed in daltons.</td>
</tr>
<tr>
<td>atomic number</td>
<td>the number of protons in an atomic nucleus.</td>
</tr>
<tr>
<td>average mass</td>
<td>the mass of an ion calculated using the relative average isotopic mass of each element (where C = 12.0111, H = 1.00797, O = 15.9994, and so on).</td>
</tr>
<tr>
<td>base peak</td>
<td>the peak in a mass spectrum corresponding to the m/z value that has the greatest intensity.</td>
</tr>
<tr>
<td>BPI</td>
<td>base peak intensity.</td>
</tr>
<tr>
<td>CID</td>
<td>collision induced dissociation.</td>
</tr>
<tr>
<td>CVF</td>
<td>cone voltage fragmentation.</td>
</tr>
<tr>
<td>dalton</td>
<td>a unit of mass 1/12 of the mass of the most abundant isotope of carbon, carbon 12, which is assigned a mass of 12.</td>
</tr>
<tr>
<td>DDA</td>
<td>data-directed analysis.</td>
</tr>
<tr>
<td>dead time</td>
<td>the data acquisition system for the instrument is a time-to-digital converter (TDC). This is an ion counting system that generates a mass spectrum by storing the ion arrival times in a histogram memory. After the arrival and registration of an ion by the TDC, there is a minimum time interval before a subsequent ion arrival can be registered. This interval is called the “dead time” of the TDC and is of the order of 5 nanoseconds.</td>
</tr>
<tr>
<td>desolvation</td>
<td>the action by which a nebulized (or sprayed) sample is dried to remove the solvent component.</td>
</tr>
<tr>
<td>DXC™</td>
<td>dynamic external calibration. On a time-of-flight mass spectrometer, if the temperature of the lab changes, the mass position of a peak detected also changes because of expansion of the flight tube. To compensate for this, Waters instruments can be equipped with DXC technology.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>------</td>
<td>------------</td>
</tr>
<tr>
<td>EPC</td>
<td>embedded PC; the computer inside the instrument that connects to the control PC and the instrument electronics.</td>
</tr>
<tr>
<td>EPCAS</td>
<td>embedded personal computer acquisition system.</td>
</tr>
<tr>
<td>ESI</td>
<td>electrospray ionization.</td>
</tr>
<tr>
<td>Experiment file</td>
<td>The method file created by the MS method editor.</td>
</tr>
<tr>
<td>FWHM</td>
<td>full width at half maximum.</td>
</tr>
<tr>
<td>GFP</td>
<td>glu¹-fibrinopeptide B.</td>
</tr>
<tr>
<td>HPLC</td>
<td>high performance liquid chromatography.</td>
</tr>
<tr>
<td>Ion</td>
<td>an atom, or a group of atoms, that has acquired a net electric charge by gaining or losing one or more electrons.</td>
</tr>
<tr>
<td>Isotope</td>
<td>one of two or more atoms having the same atomic number but different atomic masses.</td>
</tr>
<tr>
<td>Isotopic abundance</td>
<td>the naturally occurring distribution of the same element with different masses: $^{12}\text{C}=12.0000=98.89%, \quad ^{13}\text{C}=13.0034=1.1%$, for example.</td>
</tr>
<tr>
<td>Inlet file</td>
<td>stored in the AcquDb folder of the MassLynx project, the inlet file stores the parameters for the inlet system of your choice.</td>
</tr>
<tr>
<td>Inlet Method editor</td>
<td>accessed from the MassLynx instrument shortcut bar or the sample list, and used to create and edit the Inlet file.</td>
</tr>
<tr>
<td>LED</td>
<td>light-emitting liode.</td>
</tr>
<tr>
<td>LC</td>
<td>liquid chromatography.</td>
</tr>
<tr>
<td>MALDI</td>
<td>matrix-assisted laser desorption ionization.</td>
</tr>
<tr>
<td>MCP</td>
<td>multichannel plate (ion collector).</td>
</tr>
<tr>
<td>Method editor</td>
<td>accessed from the MassLynx instrument shortcut bar or the sample list, and used to create MS method files.</td>
</tr>
<tr>
<td>Method file</td>
<td>The file created in the MS method editor, sometimes referred to as the experiment file.</td>
</tr>
<tr>
<td>MRM</td>
<td>multiple reaction monitoring.</td>
</tr>
<tr>
<td>MS</td>
<td>mass spectrometer.</td>
</tr>
<tr>
<td>MS&lt;sup&gt;E&lt;/sup&gt;</td>
<td>a parallel fragmentation data acquisition mode that enables precursor and fragment ions to be analyzed simultaneously.</td>
</tr>
<tr>
<td><strong>nebulization</strong></td>
<td>process by which the sample solution is transformed into a fine mist in the source, also referred to as the spray.</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>nominal mass</strong></td>
<td>mass of an ion calculated using the integer mass of the most abundant isotope of each element (where the mass defect is neglected, giving $H = 1$, $C = 12$, $O = 16$, and so on).</td>
</tr>
<tr>
<td><strong>oa-TOF</strong></td>
<td>orthogonal acceleration time-of-flight.</td>
</tr>
<tr>
<td><strong>Operate mode</strong></td>
<td>the instrument mode in which high voltages are switched on. Data can be acquired in this mode. The instrument can be left in this mode.</td>
</tr>
<tr>
<td><strong>PEG</strong></td>
<td>polyethylene glycol.</td>
</tr>
<tr>
<td><strong>penning gauge</strong></td>
<td>gauge used to measure pressures from approximately $10^{-3}$ to approximately $10^{-8}$ mbar, the range in which the turbomolecular pumps operate.</td>
</tr>
<tr>
<td><strong>piranni gauge</strong></td>
<td>gauge used to measure pressures from approximately atmospheric to approximately $10^{-3}$ mbar, the range in which the roughing pumps (rotary and scroll) operate.</td>
</tr>
<tr>
<td><strong>sample list</strong></td>
<td>the area in the main MassLynx window in which all the necessary parameters (MS method, inlet, tune, and so on) are defined for a list of samples.</td>
</tr>
<tr>
<td><strong>Standby mode</strong></td>
<td>the instrument mode in which high voltages are switched off. Data cannot be acquired in this mode.</td>
</tr>
<tr>
<td><strong>TDC</strong></td>
<td>time-to-digital converter.</td>
</tr>
<tr>
<td><strong>TIC</strong></td>
<td>total ion count.</td>
</tr>
<tr>
<td><strong>TOF</strong></td>
<td>time-of-flight.</td>
</tr>
<tr>
<td><strong>tune file</strong></td>
<td>stored in the AcquDb folder of the MassLynx project, the tune file stores the parameters for the mass spectrometer.</td>
</tr>
<tr>
<td><strong>Tune window</strong></td>
<td>the MassLynx module where the mass spectrometer is controlled. Tune parameters can be set and the instrument calibrated for exact mass.</td>
</tr>
<tr>
<td><strong>UPLC®</strong></td>
<td>ultra performance liquid chromatography.</td>
</tr>
</tbody>
</table>
Index

Symbols
*
.ipr 2-9
*.rpt 3-27

A
absolute quantitation 1-3, 1-5
acceptance criteria 3-20
Acqdb folder 2-9
acquiring data 1-5
  for calibration 2-21
  for LC-MS test 3-13
  for system verification 3-19
ACQUITY UPLC Console 2-5
additives B-8
advice, safety A-1
Atlantis columns 3-2, 3-3, D-1
attaching raw data 4-7, C-3
Auxiliary Solvent Manager 2-5

B
baffle, reference 2-13
beam, effect on 2-12
BEH columns 3-2, 3-3
  suggested parameter values D-1
Binary Solvent Manager 2-5
biohazard warning A-4
BPI chromatogram 3-13, 3-14
burst warning A-3

C
calibration
  acquiring data 2-21
  Q-Tof Premier 2-19
  solution 2-20
calibration standards B-2
  glu-fibrinopeptide B B-3
  sodium formate B-3
  capillary voltage
    effect on beam 2-13
    troubleshooting 2-12
  caution symbol A-5
  Center parameters 2-21
  checking
    ion intensities 3-20
    mass accuracy 3-20
    peak area 3-20
    retention time 3-20
  chemical hazard warning A-5
  chromatogram, BPI 3-13, 3-14
  chromatography, microcapillary 1-2
  collision energies
    elevated 1-4
    low 1-4
  collision gas 2-14
  columns
    Atlantis 3-2, 3-3
    BEH 3-2, 3-3
    conditioning 3-10
    suggested parameter values D-1
    trapping 3-2, 3-3
  compounds, lock mass references B-2
  conditioning the column 3-10
  configuring
    hardware 1-3
    inlets 2-4
    MassLynx 2-3
    MS system 3-10
    software 1-3
  connecting, injector valve 2-6
  Container Manager tool 4-6
  containers, creating C-3
  creating
experiments 4-7
MassLynx project 2-8
creating (in PLGS)
containers C-3
Expression analyses C-6
processing parameters templates 4-6, C-3
projects C-2, D-2
samples in Sample Manager 4-6, C-2
vials C-3
workflow templates 4-7
criteria for acceptance, LC-MS
verification test 3-20

D
data
acquiring 1-5
attaching C-3
Expression 1-5
MS\textsuperscript{E} 1-5
processing C-3
data bank searching 1-4, C-6
Data Preparation tool 4-6
data processing 1-4
data-directed analysis 1-2
DDA 1-2
deployment 1-4
detector voltage 2-14
digestion procedures
  in-gel B-8
  solution phase B-8

e
E.\textit{coli} B-5, B-7
electrical symbols A-12
elevated collision energy 1-4
EMRT 1-5
  results table C-6
enolase 3-21, 3-25

equipment guidelines vii, A-5
exact mass retention time 1-5
expected performance levels 3-11
experiments
  creating 4-7
  software workflow 4-5
Expression analysis
  creating 4-2, 4-7
  running 4-2, C-6
Expression data 1-5
Expression experiments
  creating C-6
Expression software 4-2
  installing license 4-4
extraction cone voltage 2-13

F
final concentrations 3-20
flammable solvents A-3
fragment data, low and high energy 1-4, 4-7
full loop mode 2-6

G
gas cell pressure 2-14
gas, NanoFlow 2-14
glu-fibrinopeptide B-3
  infusing 2-10
  gradient length D-2

H
handling symbols A-13
hardware configuration 1-3
hazard symbols A-1
high energy fragment data 4-7

I
ICAT experiments 1-1
identification, qualitative 1-3
importing data C-3
in source fragmentation, tuning 2-17
infusing, glu-fibrinopeptide 2-10
injector valve
    connecting 2-6
inlet configuration 2-4
instrument tuning standards B-2
instrument, specifications B-1
ion accounting 1-4
ion beam
    factors 2-12
    obtaining 2-10
    optimizing 2-14
ion intensities
    checking 3-20
    threshold 3-24
isobaric experiments 1-1
isotopic labeling 1-2, 4-7
items exposed to solvent E-2
iTRAQ experiments 1-1

L
label-free experiments 4-7
LC gradient length D-2
LC-MS verification test 3-11
mass accuracy 3-11
    retention time precision 3-18
license, Protein Expression 4-4
lock mass 3-22
    correction 2-22
    reference compounds B-2
loop mode
    full 2-6
    partial 2-6
low collision energy 1-4
low energy fragment data 4-7

M
mass accuracy
    check 3-20
    verification test 3-11
Mass Measure parameters 3-16
mass spectrometer shock hazard A-4
MassLynx
    configuration 2-3
    control 2-3
    project 2-8
    tune file 2-8
method parameter values, suggested D-1
methods
    OpenLynx 3-20
    quality control 3-20
microcapillary liquid chromatography 1-2
microkernel, PLGS 4-5
mobile phases 3-4
    common ingredients E-3
MS profile 2-18
MS scan conditions 3-11
MS scan time D-2
MS system configuration 3-10
MS^E data 1-2, 1-5
MS^E processing 1-4

N
nanoACQUITY 2-2
    methods 3-6
    setup 2-3
    system configuration 3-4
NanoFlow gas 2-14

O
objects in PLGS projects
    containers 4-5
    creating 4-5
    samples 4-5
obtaining an ion beam 2-10
opening, tune file 2-9
OpenLynx QC methods 3-20
Operate button 2-9
P
parameter values, suggested D-1
parameters
centering 2-21
mass measuring 3-16
smoothing 2-21
TOF accurate mass 3-17
partial loop mode 2-6
peak area
checking 3-20
threshold 3-23
performance level, expected 3-11
performance verification standards
B-3, B-6
performing a data bank search C-6
PLGS 4-2, C-1
preparation of samples, standard compounds B-2
pressure, gas cell 2-14
priming pumps 2-4
probe tip 2-12, 2-14
processing parameters templates
creating in PLGS 4-6, C-3
description 4-6
setting C-4
processing raw data 4-7, C-3
processor, PLGS 4-5
projects
creating in PLGS C-2, D-2
MassLynx 2-8
setting up in PLGS 4-5
Protein Expression experiments
creating and running C-6
Protein Expression software 4-2
installing license 4-4
ProteinLynx Global SERVER 4-2
microkernel 4-5
processor 4-5
search engine 4-5

Q
Q-Tof Premier calibration 2-19
qualitative identification 1-3
quality control methods 3-20
quantitation
absolute 1-3, 1-5
relative 1-5
quick start tutorial C-1

R
raw data 4-5
attaching 4-7
processing 4-7
raw data in PLGS projects 4-5
reagents, sample digestion B-8
reference baffle 2-13
reference compounds, lock mass B-2
reference solution 3-5
relative quantitation 1-5
required solvents 3-4
retention time
checking 3-20
precision 3-18
threshold 3-23
RF settings 2-18
running
data bank search C-6
Expression analyses C-6

S
safety advisories A-1
safety, solvents E-1
sample cone voltage 2-13
sample data 4-4
sample digestion, reagents B-8
sample list, system verification 3-5
Sample Manager
settings 2-6
tool 4-6
samples
  creating in Sample Manager 4-6, C-2
system verification 3-5
scan time D-2
search
data bank C-6
search engine, PLGS 4-5
search types 4-7
serum digestion, solutions B-11
set processing parameters template C-4
setting up projects in PLGS
  containers 4-5
  description 4-5
  objects 4-5
  raw data 4-5
  samples 4-5
setup, nanoACQUITY 2-3
smooth parameters 2-21
sodium formate B-3
sodium iodide B-2
software configuration 1-3
software workflow, description 4-5
solutions
  reference 3-5
  serum digestion B-11
solvent, items exposed to E-2
solvents
  compliant E-1
  required 3-4
source temperature 2-14
spectrum
  of eluted peptide 3-15
  smoothed, centroided, lockmass-corrected 3-18
sprayer positioning 2-13
standards
calibration B-2
instrument tuning B-2
performance verification B-3, B-6
Standby button 2-8
Stream Parameters dialog box 3-23
symbols
  caution A-5
  electrical A-12
  handling A-13
  hazard A-1
  warning A-2
system configuration
  MS 3-10
  nanoACQUITY 3-4
system verification 3-1
  conditioning the column 3-10
  required solvents 3-4
  sample list 3-5
  samples 3-5
  test 3-19
T
TDC settings 2-19
temperature, source 2-14
templates
  processing parameters
    creating C-3
    setting C-4
threshold
  ion intensities 3-24
  peak area 3-23
  retention time 3-23
TOF Accurate Mass parameters 3-17
trapping columns 3-2, 3-3
troubleshooting the ion beam 2-12
tune file
  MassLynx 2-8
  opening 2-9
Tune window 2-8
tuning
  instrument standards B-2
  mass spectrometer 2-14
tutorial, quick start C-1

V
verification test
  LC-MS
    mass accuracy 3-11
    retention time precision 3-18
    system 3-19
verification, performance standards
  B-3, B-6
vials, creating in PLGS C-3
voltage
  detector 2-14
  extraction cone 2-13
  sample cone 2-13

W
warning symbols A-2, A-5
Workflow Designer 4-6
workflow templates, creating in PLGS
  4-7